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Resumen del proyecto:

Este proyecto tiene como finalidad conocer la historia y realizar la modelizacidon y el estudio del
comportamiento dinamico del Citroén 2CV.

En primer lugar, analizaremos la historia del vehiculo y como ha ido evolucionando con el
transcurso de los afios.

Seguidamente, se describiran los diferentes subsistemas que conforman el vehiculo en su modelo
Citroén 2CV 4 mas basico como son la suspension delantera, la suspension trasera, la direccién, el
chasis, las ruedas, el motor y los frenos.

Una vez descritos los diferentes subsistemas, se procedera a implementarlos en el programa
informatico Adams Car, en el cual analizaremos el comportamiento de las suspensiones y del
vehiculo en su totalidad.

Finalmente, tras obtener los resultados los contrastaremos con la realidad y realizaremos un
presupuesto del coste total del proyecto.






Abstract:

This project aims to discover the history and perform the modeling and the study of the
dynamic behavior of the Citroén 2CV.

Firstly, we look at the history of the vehicle and how it has evolved over the years.

Then, we will describe the different subsystems that compose the vehicle Citroen 2CV model 4
basic concepts such as front suspension, rear suspension, the steering, chassis, wheels, engine
and brakes.

After describing the different subsystems, we will implement them in the software Adams Car,
which will analyze the behavior of suspensions and vehicle completely.

Finally, after obtaining the results, we will contrast with the reality and make an estimate of
the total cost of the project.
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1. INTRODUCCION

1.1 Introduccion al proyecto

Alo largo de los afios, el mundo del automovilismo ha ido evolucionando en todos sus ambitos,
desde la evolucidn y optimizacidn de los sistemas de propulsién hasta los sistemas de transmision,
la estructura y la seguridad de estos.

Antiguamente, para desarrollar y evolucionar los diferentes sistemas que conforman un vehiculo
nos basabamos en la experiencia, es decir, se realizaban los desarrollos o reformas adecuadas al
vehiculo para posteriormente ensayarlo y analizar sus resultados. Este procedimiento lo podemos
conocer como método experimental. Ahora bien, como podemos deducir este procedimiento
puede tener altos costes econdmicos, debido a la repetitiva fabricacién de los modelos a analizary
SuUS ensayos.

Actualmente, es una realidad que el campo de la tecnologia y los ordenadores ha revolucionado
todos los mercados y nuestras vidas. Asi pues, el desarrollo de programas de cdlculo y analisis de
resultados ha contribuido a mejorar y optimizar, en este caso, el mundo del automovil, sus
reformas y evoluciones.

Mediante el uso de estos programas, se pueden disefiar los subsistemas que conforman un
vehiculo como pueden ser las suspensiones, la direccion, el chasis o la carroceria. Ademas,
podemos analizar su comportamiento aisladamente e incluso, uniendo todos los subsistemas,
analizar el comportamiento del vehiculo en su integridad.

La gran ventaja del desarrollo de estas potentes herramientas radica en su coste econémico. Asi
pues, no necesitamos realizar las reformas fisicas en un vehiculo y analizarlas repetidas veces.
Mediante la simulacién informatica podemos obtener resultados aproximados a la realidad, los
cuales finalmente podremos verificar analizando su comportamiento en la realidad si cumplen su
funcién o no.

Asi pues, utilizando la herramienta informatica Adams Car, modelaremos la geometria del Citroén
2CV, asi como su comportamiento para realizar un analisis dindmico del vehiculo.

1.2 Motivacién y objetivos

Una de las ramas mas importantes de la ingenieria mecanica es el estudio cinematico o
dindmico de los mecanismos.

La suspension del Citroén 2CV es una de las mas peculiares que podemos encontrar en el
mundo del automovilismo, ya sea por su peculiar geometria o por su caracteristico
comportamiento, del cual hablaremos posteriormente.

Asi pues, el poder estudiar y analizar el comportamiento de esta suspension, lo cual estd
ampliamente relacionado con el analisis de mecanismos de la ingenieria mecanica, es el
causante de la ilusion que comporta realizar este proyecto.

El principal objetivo de este proyecto se basa en modelizar en el programa informatico Adams
Car un modelo, lo m3s fiel a la realidad posible, del Citroén 2CV para poder estudiar y analizar
su comportamiento dindmico. Para ello, modelizaremos los diferentes subsistemas que

4
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componen el vehiculo, ensamblaremos la suspensién delantera, la trasera y, posteriormente,
el vehiculo completo.

Ademas, un proyecto de esta envergadura nos puede aportar muchos conocimientos
relacionados con la ingenieria, tales como:

- Aprender a utilizar diferentes programas de disefio en 3D asistido por ordenador como
pueden ser SolidWorks o AutoCAD, asi como otros mds relacionados con el analisis del
comportamiento mecdnico en la automociéon como es Adams Car.

- Conocer y estudiar el desarrollo de un vehiculo histérico como puede ser el Citroén 2CV.

- Aprender a realizar proyectos demostrando los conocimientos obtenidos durante el Grado en
Ingenieria Mecdnica.
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2. HISTORIA DEL CITROEN 2CV

2.1 Disefio, fabricacién y produccion

El ingeniero francés Pierre Jules Boulanger, a quien se le atribuye la creacion del Citroen 2CV,
empezo a desarrollar el TPV (Toute Petite Voiture o Vehiculo minimo) en los afios 30. El
objetivo de este vehiculo, tal y como podemos leer en el cuaderno de cargas, era “hacer un
vehiculo que pueda transportar a cuatro personas y 50 kg de patatas, a una velocidad de 60
km/h, con un consumo de 3 litros de gasolina cada 100 km con un confort irreprochable”.

Figura 2-1: Planos del prototipo del Citroen 2CV. Ref [1]

En el afio 1938, empezaron a realizarse las primeras pruebas en carretera del prototipo TPV, el
cual posteriormente se convertiria en el 2CV.

Figura 2-2: Prototipo TPV. Ref [2]
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Tras las primeras, en el afio 1939 se fabricaron 250 prototipos del TPV, los cuales aiin entonces
utilizaban el agua como refrigerante. Finalmente, el 23 de agosto de este mismo afio, el
Departamento de Minas aprobd el 2CV, el cual ya estaba listo para ser comercializado.

PROCES VERBAL

DE
RECEPTION
DESCRIPTION

DES VOITURES AUTOMOBILES

TYPE “2 CV A”

CONSTRUITES PAR LA
SOCIETE ANONYME
ANDRE CITROEN

CAPITAL: 210.000.000 DE FRANCS

117 A 167. QUAI DE JAVEL,
PARIS (XV*)

MOTEUR

PUISSANCE : Deux chevaux d'apres la formule®ndminisirative.

NATURE. — Moteur & explosion & § temps pouvant fonctionner
& lessence de pétrole, au benzol, & I'aleool carbure ou a I'alcool.
Il comporte 2 eylindres, alésage 62 millimétres, course 62 milli-
métres.

NOMBRE DE TOURS. — La vitesse de régime est d'environ
1.800 tours a la minute, elle peut étre réglée au moyen d'vue pédale
d'accélérateur qui agil sur l'onverture du passageé des gaz au car-
burateur.

CARBURATEUR. — A pulvérisation et nivean constant,

ALLUMAGE l‘il.liCTRlQUl’.‘ — Par élincelle et courant &
haute tension produit par une magnéto ou par unc hallerie et
uue bobine.

REFROIDISSEMENT. — Par circulation d'eau, avee radiateur.

Figura 2-3. “Descrpicion del vehiculo a motor Citroén 2CV”. Ref. [3]

Durante estos afios, Francia era una zona de conflicto debido a la Segunda Guerra Mundial.
Cuando las tropas alemanas ocuparon Francia, se decidié mantener el proyecto del 2CV en
secreto, debido al peligro de que los alemanes utilizaran el proyecto para sus propios fines.

El 6 de marzo de 1940, |la fabrica Citroén del muelle de Javel fue bombardeada. Debido a esta
situacién tan complicada, la produccién del 2CV tendia a desaparecer.
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Figura 2-4. Fabrica de Javel bombardeada por el ejército aleman. Ref [4]

Esta misma fabrica, volvié a sufrir los efector catastréficos de la guerra en el afio 1943, cuando
tuvo lugar un segundo bombardeo.

Como hemos dicho anteriormente, la produccién y el desarrollo durante la Segunda Guerra
Mundial fueron escasos. En el afio 1994, Boulanger decidié renovar el antiguo motor de 2
cilindros refrigerado por agua. Para ello, encargd disefiar una nueva unidad con un tamano de
375 cc la cual estuviera refrigerada por aire a Walter Becchia. Ademas, en el intento de
renovar la caja de cambios a 3 velocidades, se logré idear una nueva caja con 4 marchas la cual
ocupaba el mismo tamano y tenia muy poco coste adicional, lo cual era algo novedoso en los
automoviles franceses, puesto que sus companeros el Peugeot 202 y el Renault Juvaquatre
generalmente contaban con 3.

Tras la guerra, en el 1945 se reconstruyé la fabrica bombardeada de Javel. Era uno de los
caminos para responder lo mas rapido posible a la demanda creciente de vehiculos.

Finalmente, tras este duro periodo, el 8 de octubre de 1948 se mostrd al publico el Citroén
2CV, en el Salén del Automovil de Paris. Este modelo poseia un motor de dos cilindros
refrigerado por aire, con un tamafio de 375 cc y una potencia de 9 CV.

Respecto a la comercializacidn del vehiculo en el territorio espafiol, se comenzé a montar en el
afio 1959 con un motor de 425 cc que desarrollaba una potencia de 12 CV. Con su evolucion,
se logré aumentar su potencia hasta los 18 CV en el afio 1964.

Su produccién, en todas sus variantes, se realizara hasta el 27 de julio de 1990 en la planta
portuguesa de Mangualde, con una venta de mas de 5 millones de unidades.
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2.2 Evolucidn de las especificaciones técnicas

Como hemos podido observar en la historia del Citroén 2CV, existen varias versiones técnicas
de este vehiculo, puesto que con los afios se han tratado de mejorar sus especificaciones
técnicas.

En primer lugar, la primera versién del 2CV, producida en el afio 1949, tenia un motor de 2
cilindros opuestos horizontalmente refrigerados por aire. Sus cilindros eran de 62 mm con una
carrera de 62 mm, proporcionando asi una capacidad de 375 cc. La relacidon de compresidn de
este modelo era de 6.2:1. La potencia maxima que se podia alcanzar con dicho vehiculo era de
9 CV a 3500 rpm y, el maximo torque, de 2 mKg a 2000 rpm. La velocidad méaxima del 2CV era
de 65 km/h

Figura 2-5. Motor bicilindrico del Citroén 2CV de 1949. Ref [5]

Respecto a la transmision del vehiculo, el 2CV es de traccidn delantera, con una caja de
cambios de 4 velocidades.

El sistema de direccidn era “rack and pinion” conocido como pifién y cremallera. La cremallera
estaba montada transversalmente en la parte delantera del vehiculo.

Respecto a la suspension, estd compuesta por brazos longitudinales, los cuales estan sujetos
en sus extremos al chasis.

Figura 2-6. Chasis y suspension del Citroén 2CV. Ref [6]
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A lo largo de estos brazos, encontramos unos resortes helicoidales dispuestos
longitudinalmente y horizontalmente a cada lado del vehiculo. En la figura anterior los
podemos encontrar con el n23.

AVANT ARRIERE

‘M n“ “."“

QE

" 2 20 - 21 7 L3

Figura 2-7. Resortes longitudinales del 2CV. Ref [7]

Estos resortes los podiamos encontrar situados bajo de las puestas del vehiculo. Ademas,
suspendian simultdneamente tanto la rueda delantera como la trasera.

Este disefo producia un andar cabeceante en el vehiculo, el cual es una de las principales
caracteristicas de este vehiculo. Ahora bien, para los giros en curva, este sistema conseguia
alcanzar grandes angulos de escora, los cuales impresionaban a cualquier espectador.

Los frenos de este primer vehiculo eran de tambor, con unos tamafios de 200 y 180 mm en las
ruedas delanteras y traseras respectivamente.

Respecto al consumo, el vehiculo requeria entre 4 y 5 litros por cada 100 km, lo cual se
aproximaba a las anotaciones en el cuaderno de cargas que escribié Boulanger para disefiar el
vehiculo.

El Citroén 2CV montaba unos neumaticos Michelin Pilote con un tamafno de 125x400.

Respecto a las dimensiones del vehiculo de 1949, este poseia una longitud de 3.78 m, una
anchura de 1.48 my una altura de 1.60 m. La batalla, es decir, la distancia entre ruedas era de
2.4 m.

La capacidad del tanque de combustible era de 20 litros y el vehiculo tenia un peso sin carga
de 495 kg.

Figura 2-8. Cuerpo del Citroén 2CV de 1949. Ref [8]

10
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2.2.2 Citroén 2CV de 1955

En el afio 1955, Citroén realizé algunos cambios respecto a su primer modelo del 2CV.

En la motorizacion del vehiculo, substituyd el motor de 375 cc por uno de 425 cc, con la misma
relacidon de compresion de 6.1:1. La potencia maxima que podia producir era de 12 CV girando
23500 rpm.

Figura 2-9. Motor de 425 cc del 2CV de 1955. Ref [9]

Ademas, incorporaron un embrague centrifugo el cual se desactivaba cuando el motor entraba
en un régimen de revolucionas bajo, conocido como ralenti, lo cual permitia conducir el
vehiculo con un pie en situaciones de trafico.

Figura 2-10. Embrague centrifugo del 2CV. Ref [10]

11
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2.2.3 Citroén Sahara 2CV de 1958

El Citroén 2CV de 1958, mas conocido como Sahara, ha sido una de las versiones mas
reconocidas de este vehiculo.

Figura 2-11. Citroén Sahara. Ref [11]

Este vehiculo era un 4x4, es decir, tenis un sistema de traccion a las 4 ruedas. El 2CV
incorporaba dos motores bicilindricos, uno situado en la parte frontal y otro en la trasera.
Dichos motores eran iguales que el de su hermano anterior, el modelo de 1955, por lo que
tenian una capacidad de 425 cc cada uno (850 en total) y producian una potencia maxima total
en el vehiculo de 24 CV, cuando estos giraban a 3500 rpm. El torque méximo, al igual que su
hermano anterior, era de 2 mKg por motor, es decir, un total de 4 mKg para este Sahara de
1958.

i b

Figura 2-12. Chasis del Citroén Sahara 2CV 4x4. Ref [12]

Los neumaticos de este modelo se redujeron, siendo sus dimensiones 155x380.

Este modelo utilizaba 2 tanques de combustible, uno por cada motor, situados bajo los
asientos frontales del vehiculo.

Respecto a los sistemas de transmision, es un vehiculo 4x4, por lo que posee traccion en las 4
ruedas. Los dos embragues son hidraulicos. Las dos cajas de cambio se controlan
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simultadneamente compartiendo la misma palanca de cambio. Ademas, mediante una palanca
se permitia que el motor trasero funcionara en punto muerto, permitiendo asi que el coche
funcionara solamente a traccién delantera. También, podia conducirse Unicamente utilizando
el motor trasero del vehiculo.

Respecto al sistema de frenos, posee frenos de tambor interiores en las 4 ruedas y el freno de
mano opera en los tambores delanteros.

Este modelo 2CV Sahara de 1958, era capaz de alcanzar una velocidad maxima de 100 km/h.
Su consumo en asfalto era de 9 litros cada 100 km, mientras que en su comportamiento
todoterreno variaba de 10 a 12 litros cada 100 km.

El primer Sahara 2CV salié a la venta en 1960 y permanecio en produccién hasta 1966.

Durante el periodo comprendido entre 1960 y 1970, el 2CV incorpord su nuevo modelo AZAM
(Amélioré o mejorado), el cual se lanzé al mercado con un motor que producia 18 cv a 5000
rpm.

En este nuevo modelo, se renovaron aspectos puramente estéticos como equipar un capé
brillante. También el interior fue mejorado incorporando asientos delanteros montados en
corredores, nuevos revestimientos a los asientos, visera para el sol incorporada para el
pasajero delantero y nuevos pomos en las partes interiores de las puertas.

m—

Figura 2-13. Modelo Citroén 2CV de 1960. Ref [13]

Dejando las renovaciones puramente esteticas de 2CV, en este periodo también se
modificaron partes técnicas del vehiculo.

Uno de los cambios mds importantes fue la introduccidn de los nuevos sistemas de
amortiguacion. Se sustituyeron los antiguos amortiguadores situados en las ruedas traseras
por unos nuevos amortiguadores telescopicos situados en las barras longitudinales del chasis.
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L
Figura 2-14. Nuevos amortiguadores traseros del Citroén 2CV en 1966. Ref [14]
Las ventanas laterales del vehiculo también se renovaron. En la actualidad, este sistema de

anclaje de ventanillas es uno de los sistemas caracteristicos de este vehiculo mds conocidos
popularmente.

L
Figura 2-15: Sistema de anclaje en las ventanillas laterales del 2CV. Ref 15]
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En el afio 1970 se lanzaron al mercado dos nuevos modelos de este vehiculo.

En primer lugar, tenemos el Citroén 2CV 4, el cual sustituyo el AZ y AZA, excepto en Holanda y
Alemania)

Este nuevo vehiculo incorporaba un motor con una capacidad de 435 cc, debido a sus cilindros
de 68.5 mm de didmetro y 59 mm de carrera. La relacidn de compresidon aumento respecto a
sus hermanos anteriores, siendo de 8.5:1 en este nuevo modelo. Con estas caracteristicas, el
motor imprimia una potencia de 26 cv girando a 6750 rpm y un torque de 3.1 mKg girando a
4000 rpm. La velocidad maxima que podia alcanzar era de 102 km/h y consumia alrededor de
5.4 litros cada 100 km.

‘:v;i'.' i &8 AT miBet o G o x“ '); t”""i;#mm};’ =
Figura 2-16. Citroén 2CV 4 de 1970. Ref [16]

Junto con el Citroén 2CV 4, sali6 al mercado el modelo Citroén 2CV 6, mas conocido como 3CV.

Ambos modelos eran muy similares, diferencidndose en las caracteristicas del motor. La
calificacion fiscal francesa es de 3CV, de ahi su nombre popular. La cilindrada de este 2CV 6
aumento substituyendo los cilindros del 2CV 4 por unos de 74 mm de didametro y 70 mm de
carrera, otorgando una cilindrada al vehiculo de 602 cc. Utilizando la misma relacién de
compresidn, el motor escupia una potencia de 33 cv girando a 7000 rpm y un torque de 4.3
mKg a 3500 rpm. La velocidad maxima de este vehiculo es de 110 km/h consumiendo 6.11/100
km.

Una de las caracteristicas de este 2CV 6 era su volante de un solo rayo, uno de los simbolos

caracteristicos de dicho modelo.

Figura 2-17. Volante de un solo rayo del 2CV 6. Ref [17]
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2.2.6 Fin de produccién y tabla comparativa

En el afio 1978 se cerré la produccidon del histérico Citroén 2CV. Este ultimo modelo producido
es el anteriormente mencionado Citroén 2CV 4, utilizando también el motor de 435 cc.

Figura 2-18. Ultimo model Citroén 2CV 4. Ref [18]

Como hemos podido observar a lo largo de este capitulo, durante aproximadamente unos 30
afios el Citroén 2CV ha ido actualizdndose y mejorandose respecto a sus versiones anteriores.
La multitud de variaciones que ha sufrido este vehiculo es muy extensa, por lo que hemos
hablado de las reformas principales que ha sufrido a lo largo de su vida. Para resumir los
conocimientos, incorporaremos una tabla informativa donde se exponen los diferentes
modelos producidos con sus respectivas reformas. Esta tabla la podemos encontrar en el
Anexo I.
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3. HERRAMIENTAS EMPLEADAS
3.1 MSC Adams Car

Adams Car es un software especializado en la modelizacién de vehiculos. Esta herramienta
permite crear prototipos virtuales de los subsistemas que forman un vehiculo y analizar los
prototipos virtuales tal y como podriamos analizar los prototipos fisicamente.

Con Adams Car, podemos crear ensamblajes de suspensiones y vehiculos completos para
posteriormente analizarlos y conocer su comportamiento.

Mediante esta herramienta, se crean ensamblajes definiendo los subsistemas del vehiculo,
como por ejemplo las suspensiones frontales y traseras, el sistema de direccidn, el chasis o los
frenos. Ademads, con el acceso en modo experto, Adams Car ofrece la oportunidad de basar los
subsistemas en plantillas creadas por uno mismo.

Cuando analizas el comportamiento de un ensamblaje, Adams Car aplica al analisis las
condiciones que el usuario quiera imponer. Por ejemplo, en el analisis del comportamiento de
una suspension, puedes imponer condiciones como:

- Mover las ruedas a través de un recorrido impuesto y medir la convergencia, la
inclinacion, la velocidad de la rueda, etc.

- Aplicar una carga lateral y un par de alineamiento en la huella de contacto del
neumatico con la calzada y medir el dngulo de convergencia y de caida.

- Girar el volante un determinad angulo y medir los dngulos girados por las ruedas y el
angulo de Ackerman.

Conociendo estos resultados, podemos modificar la geometria de la suspensién, los muelles o
los amortiguadores y volver a analizar el comportamiento para determinar los efectos de
dichas alteraciones.

Resumiendo, con esta herramienta el usuario tiene la posibilidad de:

- Modelizar y disefiar los diferentes ensamblajes que componen un vehiculo utilizando
los diferentes subsistemas que los componen.

- Analizar mediante diferentes pruebas el comportamiento de los ensamblajes, mas
rapida y econédmicamente que mediante pruebas reales.

- Trabajar en un entorno mas seguro sin temor a perder datos por fallos en la
instrumentacién o fallos debidos a las condiciones climaticas.

- Realizar andlisis sin los peligros asociados que tiene realizar las pruebas fisicas.
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3.2 SolidWorks

El software SolidWorks es una herramienta potente y sencilla que permite disefiar y producir
modelos en 3D.

SolidWorks permite modelar piezas y conjuntos, ademas de extraer informaciéon como planos
técnicos, medidas, etc. También cuenta con herramientas de simulaciéon, movimiento y
validacién de los disefios, con lo que podemos validar la fabricacion de un producto y resolver
problemas relacionados con el ensamblado que se puedan dar en las diferentes fases del
disefo. Este programa funciona mediante las nuevas técnicas de modelado con sistemas CAD.

Ademas, el paquete SolidWorks Solutions incluye diferentes herramientas como son:
- Disefio 3D
- Simulacidn
-Disefio eléctrico
- Gestion de datos de productos
- Comunicacidn técnica

- 3DExperience
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4. CONDICIONES DE DISENO

Como hemos descrito anteriormente en el capitulo 2, en el apartado de Evolucion de las
especificaciones técnicas, existen diferentes versiones del Citroén 2CV, ya sea de aspectos mas
técnicos como pueden ser la motorizacidn o la direccidn, o bien en aspectos relacionados a las
dimensiones del vehiculo o las geometrias de las suspensiones.

Para realizar el modelado del vehiculo y analizarlo con la herramienta Adams Car, debemos
seleccionar una de las diferentes variantes del vehiculo.

El modelo elegido para modelar y analizar su comportamiento con Adams Car sera la version
Citroén 2CV 4. La motivacion a elegir este vehiculo radica en la fiabilidad de los datos de
partida, puesto que es el modelo mas reciente y del que mds informacidén podemos obtener.
Ademas, dado que tenemos la oportunidad de acceder a un modelo en la vida real, nos
facilitard las mediciones para la modelizacion de las geometrias de los subsistemas y podremos
utilizar dicho vehiculo a lo largo de la redaccidn del proyecto.

De igual manera, algunos datos como pueden ser las inercias o los pesos de diferentes
componentes del vehiculo se estimaran, debido a la imposibilidad de conocer con exactitud
dichos valores y a su complejidad.

Como resultado de todas las simplificaciones anteriores, los resultados seran una
aproximacion a los valores reales.
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5. MODELIZACION DEL CITROEN 2CV

5.1 Carroceria

La carroceria es el subsistema del vehiculo que proporciona la estructura basica del automovil.
Sobre ella se situan los pasajeros y la carga del vehiculo, ademas de otros subsistemas como
pueden ser el motor, la transmisidn o las suspensiones.

Como veremos mas adelante, diferentes subsistemas como los mencionados anteriormente se
anclan a la carroceria, por lo que esta estard sometida a diversas solicitaciones debidas a las
uniones.

Para realizar la modelizacién de la carroceria del 2CV, partiremos del archivo de SolidWorks
facilitado por el profesor Josep Lluis Sufier, el cual es un disefio en 3D del modelo Charleston
del 2CV.

Figura 5-1. Citroén 2CV Charleston. Ref [19]

En primer lugar, abriremos el archivo inicial en SolidWorks. En Adams Car, los neumaticos son

subsistemas diferentes a la carroceria, por lo que por razones estéticas eliminamos las ruedas
de nuestro modelo CAD. Este modelo en 3D esta reproducido a escala real, por lo que no serd
necesario escalar el disefio y todas las medidas seran a tamafio real.

Tras eliminar las ruedas de nuestro modelo 3D, procederemos a guardar el archivo para
posteriormente importarlo en Adams Car. Para ello, se recomienda guardar el disefio en
formato Parasolid (.x_t), puesto que Adams Car posee mayor compatibilidad con los disefios
en este formato.

Una vez exportado el modelo en Parasolid, procedemos a importarlo en Adams Car. Para ello,
iniciamos Adams en el modo Template Builder. Este modo, permite al usuario crear y modificar
las diferentes plantillas que posteriormente formaran los subsistemas del vehiculo. Para
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realizar la plantilla del cuerpo del 2CV, abriremos la plantilla ya creada que ofrece Adams del
vehiculo Sedan (_rigid_chassis_sedan).

Figura 5-2. Plantilla _rigid_chassis_sedan

Seguidamente, eliminamos los diferentes solidos que componen la carroceria del Sedan
mediante la operacién Edit -> Delete. Una vez eliminados los sélidos del Sedan, importaremos
el archivo Parasolid de nuestro modelo del 2CV. Para ello, mediante File -> Import
importaremos nuestro modelo, agregando el disefio a la parte ges_chassis. Dado que nuestro
modelo posee una localizacién y orientacion diferente a la buscada, sera necesario realiza una
correccion de estos parametros. En nuestro caso, importaremos el archivo tal y como se
presenta en la Figura 5-3.

d
File Type | Parasolid (*.xmt_txt, *x_t, “xmt_bin, *x b)  ~|
File To Read | C:\Users'xavig\Desktop\Programas\citroen 2CV x_t
File Type | AsCl ~| Ref Markers | Global ~|

Part Name j |__rigid_chaaaia_sedan_ges_chaasia

Location 0,750,0

Orientation 10.0, 90.0, 0.0

Relative To |

[ Explode Assembly

Geometry Cptions | Ok Apply Cancel

Figura 5-3. Importacion del modelo 3D del 2CV.

Tras importar el modelo del 2CV, nuestra plantilla tendra el disefio de nuestro Citroén con
todos los parametros, comunicadores, partes y montajes del Sedan. Dado que posteriormente
crearemos completamente la suspensién frontal y trasera del vehiculo, serd necesario afiadir
un comunicador el cual conectara el chasis con las suspensiones.
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Para crearlo, en el menu Build -> Comunicator -> Output -> New crearemos un comunicador tal
y como podemos observar en la Figura 5-4.

L |

Output Communicator Name | pady.cor_arm_to_body

Matching Mame(s) arm to body

Type " left & right € single

Entity | mount J

To Minar Role |inherit j

Part Name |._bndy.gea_chaaais

‘ List Inputs | OK | Apply Cancel

Figura 5-4. Comunicador arm_to_body.

Una vez agregado este nuevo comunicador, guardaremos la plantilla en nuestra base de datos
mediante el comando Save as, con el nombre _body y el Major Role body en la carpeta
templates.tbl.

Una vez creada la plantilla de nuestro modelo, deberemos crear su propio subsistema puesto
que es necesario para el ensamblado del vehiculo. Para ello, abriremos Adams en su versidn
Standard Interface y mediante File -> New -> Subsystem creamos el nuevo subsistema llamado
_body_c2cv con Minor Role any.

Figura 5-5. Subsistema _body_c2cv.

Una vez creado el subsistema con la parte mas estética de la carroceria, procederemos a
introducir la masa y calcular una aproximacion de los valores inerciales de nuestro vehiculo
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Para calcular las inercias partiremos de la hipdtesis de que nuestro vehiculo tiene forma de
paralelepipedo, con las dimensiones reales del vehiculo expuestas en el Anexo Il

Seguidamente, mediante las ecuaciones para calcular la inercia de un paralelepipedo
calculamos:

1
Ixx = o* Masa = (h? + a?) = 2.405E + 08 kgmm?
1
lyy = 15 * Masa x (I> + h?) = 8.61445E + 08 kgmm?

1
Izz = =+ Masa = (I + a?) = 8.45945E + 08 kgmm?

donde:

Masa (masa de la carroceria) = 600 kg
| (largo del vehiculo) = 3830 mm

h (altura del vehiculo) = 1600 mm

a (anchura del vehiculo) = 1500 mm

Una vez calculados los valores inerciales de la carroceria los introducimos en Adams. Para ello,
en el submenu Browse, abrimos la carpeta Parts -> General Parts -> ges_chassis -> Modify,
introducimos los valores de la masa y las inercias y aplicamos la nueva configuracion.

Finalmente, guardamos el subsistema creado en nuestra base de datos.

L]

General Part |.bndy_2cv.ges_chassis

Location |[]_[]_U.[J.U.U

Orient using + EulerAngles  Direction Vectors

Euler Angles |[]_[],[J_[J,[J_[]

X Vector 1.0.0.0,0.0

Z Vector 000010

MESSW Sprung Mass % |1[][]_[] |any j
lxx| 2 405E+08 [ Off-Diagonal Terms
lyy| §.61445E+08
lzz | § 45045E+08

CM location relative to Part | 1900.0,0.0,700.0

Density * Material ¢ User Entered
Material Type | steel j
Symmetric * yes © no

Figura 5-6. Masa e inercias de la carroceria del 2CV.

RigidtoFlex| 0K | Apply | Cancel
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5.2 Suspension Frontal

La suspension de un automoévil tiene como finalidad absorber las irregularidades del terreno
por el que se circula para poder controlar el vehiculo y aumentar la comodidad. Ademas, una
de las funciones principales es mantener el contacto neumatico-terreno, puesto que si el
neumatico se despega de la calzada no podemos aplicar el concepto de automévil como tal.

Las funciones del sistema de suspensidn son:

- Proporcionar un comportamiento vertical consiguiendo que las ruedas superen los
desniveles del terreno y aislando la carroceria de las irregularidades de la calzada.

- Reaccionar a las fuerzas de control que de transmiten desde la huella de contacto del
neumatico tales como las fuerzas longitudinales, laterales y pares de frenado y direccién.

- Mantener la posicion de los neumaticos y la direccidon respecto a la superficie de la
carretera.

- Resistir el movimiento de balanceo de la carroceria.

Para el estudio de las suspensiones, se considera el vehiculo como dos masas diferentes. En
primer lugar, estan las masas suspendidas, las cuales como su nombre indica estan soportadas
por el chasis. En nuestro 2CV, podemos identificar estas masas como el motor o la carroceria.
También encontramos las masas no suspendidas, las cuales estdn en contacto directo con la
calzada. Basicamente este grupo esta formado por las ruedas, las cuales estan en contacto con
el suelo.

$e

Z Masa suspendida
M #e
|
K C
I::J Suspensicn
ZI|
Masa no suspendida
m

Suglo

Figura 5-7. Modelo de un cuarto de vehiculo de 2 g.d.l. Ref [20]

Como podemos observar en la anterior figura, el sistema de amortiguacién de un vehiculo no
solo estd formado por la suspensidn, sino también por el neumatico. Ahora bien, en este
apartado nos basaremos en la amortiguacion debida a la suspension.

Existen muchas clasificaciones de suspensiones diferentes puesto que se han desarrollado
muchos sistemas a lo largo de los ultimos afios. La clasificacion mas general que podemos
hacer es diferenciar las suspensiones entre dependientes e independientes.
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Un sistema de suspension dependiente es aquella en el que las ruedas montadas en el mismo
eje se encuentran unidas entre si, de tal forma que el movimiento vertical de una rueda afecta
a la rueda con la que comparte eje.

Por el contrario, las suspensiones independientes son las que no existe una unién entre las
ruedas de ambos costados, de tal forma que el movimiento vertical de una rueda no afectaala
otra.

Hoy en dia, debido al abaratamiento de sistemas de transmisién como juntas cardan o juntas
homocinéticas, las suspensiones independientes han abarcado casi todos los terrenos de la
automocidn, empleando las suspensiones dependientes en vehiculos de bajo coste o
industriales.

Las suspensiones tienen gran influencia en el comportamiento del vehiculo. Asi pues,
dependiendo de su geometria y construccidn, pueden variar la alineacidn de las ruedas y
provocar una sensacion extrafia en la direccién o un desgaste irregular en los neumaticos.

Dependiendo del plano de aplicacién del dngulo de la rueda, encontramos:

- Angulo de caida (camber): es el angulo formado por la inclinacién respecto al plano
vertical. Este angulo genera la aparicion de fueras laterales en el neumatico, conocidas como
“empuje del dngulo de caida”.

Caida positiva Caida negativa

Figura 5-8. Angulo de caida. Ref [21]
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-Angulo de convergencia/divergencia (toe): identifica la direccién hacia la cual
apuntan las ruedas comparandolas con la direccidn longitudinal del vehiculo. La convergencia

TOE OUT ()

Figura 5-9. Angulo de convergencia/divergencia. Ref [22]
se da cuando las ruedas estan orientadas hacia el interior del vehiculo y divergencia cuando

apuntan hacia el exterior.

-Angulo de avance (caster): es el angulo formado por la prolongacién del eje del pivote
con el eje vertical que pasa por el centro de la rueda en su direccidon de avance.

Figura 5-10. Angulo de avance. Ref [23]

Respecto a la suspension de nuestro Citroén 2CV, analizando su movimiento y sus
especificaciones técnicas podemos afirmar que es una suspensiéon independiente, puesto que
el movimiento vertical de la rueda de un lado no provoca esfuerzos en la del otro.

El Citroén 2CV posee una suspension caracteristica, puesto que es diferente a la del resto de
vehiculos del mercado. Existen muchas variantes de esta misma geometria tal y como se indicé
en el capitulo de Historia del 2CV, con amortiguadores inerciales en las ruedas,
amortiguadores traseros o, en su Ultima version, amortiguadores tanto en la parte frontal
como en la trasera del vehiculo.

En este proyecto modelaremos la Ultima versidon de las suspensiones del 2CV, puesto que es la
mas actual y la que posee nuestro modelo.
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5.2.3 Modelizacién de la suspension delantera

En primer lugar, tras buscar en el catdlogo que ofrece Adams Car con diferentes plantillas de
suspensiones, decidimos crear la suspensidon completa, puesto que su geometria y forma de
funcionar no se parece a los modelos del catalogo.

Para crear una suspension abrimos Adams Car en su interfaz Template Builder y seleccionamos
File -> New Template y nombramos nuestra suspensién como _suspension_frontal y de Major
Role seleccionaremos suspension.

El primer paso para realizar la modelizacién es determinar los puntos (hardpoints) que
formaran nuestra suspension. Tras medir en nuestro propio vehiculo y compararlas con las
medidas afiadidas en el Anexo Il, crearemos los hardpoints con sus respectivos nombres y
posiciones mediante el comando Build -> Hardpoint -> New. Si dejamos por defecto la
seleccidn left que viene de serie con el programa, se crearan dos hardpoints en nuestro
modelo, uno en la parte izquierda y otro en la derecha.
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En la figura 5-12 podemos observar los hardpoints creados para nuestro modelo 2CV.

loc_x

loc_y loc_z

hpl_arm_1

hpl_arm_2

hpl_arm_3

hpl_center_upright

hpl_drive_shaft_inr

hpl_lwr_circle_upright

hpl_spring_1

hpl_spring_2

hpl_tierod_inner

hpl_tierod_outer

hpl_top_circle_upright

hpl_wheel_center

hpl_wheel_to_arm

Figura 5-12. Hardpoints de _suspension_frontal del 2CV

Los construction frames, a diferencia de los hardpoints, también almacenan la orientacién del
punto, por lo que son bloques basicos en la construcciéon de muchos componentes. Para crear

los constructrion frames, utilizaremos el menu Build -> Contstruction Frame -> New. En nuestro
modelo hemos creado los siguientes construction frames:

‘ Modify Construction Frame

Construction Frame I ._suspension_frontal_ground.cfl_wheel_center

& left € right ¢ single

Type

Location Dependency I Delta location from coordinate j

Coordinate Reference I __suspension_frontal_ground hpl_wheel_center

Location I 0,00

Location in @ local © global
Orientation Dependency IToe.l’Camher j
Variable Type

I Parameter Variables j

Toe Parameter Variable I __suspension_frontal pvl_toe_angle

Camber Parameter Variable I ._suspension_frontal.pvl_camber_angle

oK Apply Cancel

Figura 5-13: Cfl_wheel_center
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Como podemos observar, la orientacidn de la rueda depende de los dngulos anteriormente

mencionados toe y camber. Las variables han sido introducidas anteriormente mediante Build -
> Parameter Variable -> New y se les ha otorgado un valor nulo.

Wl Modify Construction Frame

Construction Frame

I ._suspension_frontal.ground.cfl_spring_2

Type & left  right © single
Location Dependency I Delta location from coordinate j
Coordinate Reference I __suspension_frontal ground_hpl_spring_2
Location IEU, 0,0
Location in " local & global
Crientation Dependency I User entered values j
Orient using @ Euler Angles ¢ Direction Vectors
Euler Angles I[], 0,0
X Vector [100000
Z Vector I[J_[J,[]_[]j_o

oK Apply Cancel

Figura 5-15. Cfl_spring_2

Construction Frame

@ Modify Construction Frame

I ._suspension_frontal.ground.cfl_drive_shaft_otr

Type & left € right € single
Location Dependency I Delta location from coordinate j
Coordinate Reference I ._suspension_frontal.ground.cfi_wheel_center
Location I 0.0, 0.0, (-1.0* _suspension_frontal.pvl_drive_shaft_offset)
Location in & local " global
Orientation Dependency I Orient axis to point j

Coordinate Reference

I ._suspension_frontal.ground_hpl_wheel_center

Axis

©Z X

oK | Apply | Cancel

Figura 5-14. Cfl_drive_shaft_otr
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Estos dos ultimos construction frames se han creado para la geometria del cilindro de la parte
spindle y para la orientacién de la unién entre los springs y el body respectivamente.

El valor del pardmetro pvl_drive_shaft offset es de 50, tal y como se ha creado en la plantilla
_macpherson, la cual se ha utilizado como modelo patrén para conocer los pardmetros,
comunicadores y montajes necesarios para implementar correctamente la suspension en
Adams Car.

Una vez creados todos los puntos sobre los que se basara nuestra estructura, procederemos a
crear las diferentes partes que componen la suspension.

Para crear una General Part, existen diversos caminos dependiendo de nuestra necesidad de
construccion. La forma mas simple e intuitiva para crearlas es mediante Build -> Parts ->
General Parts -> Wizard. De este modo, se pueden crear partes con su respectiva geometria.
Esta funcion es util para crear partes que solamente se basen en un link o arm. El otro método
para crear una nueva General Part es mediante Build -> Parts -> General Parts -> New. De esta
segunda forma, podemos crear una General Part sin dotarla de una geometria inicial,
solamente mediante una localizacidn y orientaciéon. Ademas, se pueden introducir
directamente las masas e inercias de estas.

Nuestro modelo de suspensidn esta compuesto por las siguientes General Parts:

-Spindle: esta General Part representa el eje sobre el cual giran las ruedas. En su
construccién se ha utilizado una geometria cilindrica para otorgarle una forma similar a la
realidad. Para crear la geometria cilindrica, seleccionamos Build -> Geometry -> Cylinder ->
New. Las caracteristicas de este cilindro son las siguientes:

@l Modify Cylinder Geometry x

Cylinder Name _suspension_frontal ger_spindle gracyl_spindle

General Part |__suspensinn_frontal_ger_spindle
Construction Frame |

_suspension_frontal.ground.cfr_drive_shaft_otr

Radius |2[]_[J
Length In Positive Z | 50.0
Length In Negative Z | 0.0

Color dark gray -

Iw Calculate Mass Properties of General Part

Density « Material © User Entered
Material Type steel -
oK | Apply Cancel

Figura 5-16. Construccion de la geometria cilindrica se spindle
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Seleccionando la casilla Calculate Mass Properties of General Part afiadimos la masa y la
inercia de la geometria realizada a su respectiva General Part. La localizacién y orientacion de
spindle dependerd de los neumdticos, tal y como podemos observar en su informacion.

L

General Part

| __suspension_frontal gel_spindle

Type & left € right ¢ single

Location Dependency | Delta location from coordinate j

Coordinate Reference | ._suspension_frontal_ground.hpl_wheel_center

Location |[j‘ 0.0
Location in @ local © global
Orientation Dependency | Delta arientation from coordinate j

Construction Frame | ._suspension_frontal_ground.cfl_wheel_center

Crientation |0‘ 0.0

Mass | 0.475942882 |100.0  Sprung Mass %

x| 145 3774747 I Off-Diagonal Terms
lyy| 1453774747
1zz| 92 44541497

10.0.0.0.-25.0

CM Location Relative to Part

Density & Material © User Entered

Material Type |.materia|s.stee|

Ok | Apply | Cancel

Figura 5-17. Propiedades de spindle

Figura 5-18. Spindle
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-Upright: es la parte que une las ruedas a la suspensién y la direccidn, tal y como
podemos observar en el modelo real del 2CV.

B 25 o = STk
— Soereasea e

Figura 5-19. Estructura de la rueda frontal izquierda del 2CV

Para realizar la General Part y las diferentes Geometry que la conforman se han utilizado los

procedimientos anteriormente descritos. La informacion y geometria del upright la podemos
visualizar en las figuras 20 y 21 respectivamente.

il Modify General Part

General Part

I | _suspension_frontal gel_upright
Type |(=' left € right ¢ single

Location Dependency

I Delta location from coordinate j

Coordinate Reference I ._suspension_frontal_ground.cfl_wheel_center

Location I 0,00
Location in = local ¢ global
Orientation Dependency I User-entered values j
Orient using " Euler Angles ¢ Direction Vectors
Euler Angles 00,00 00
X Vector I 1.0,0.0,0.0
Z Vector I 0.0,0.0,1.0
Mass | 3 50383328¢ [1000  Sprung Mass %
|)0(| 4656.123397 I Off-Diagonal Terms

IWI 7033 70832¢
Izz| 3074 248793

I 1.3666417102,15.3241741759,-9.104868955

CM Location Relative to Part

Density

«~ Material © User Entered

Material Type I _materials.steel

ok | apply | cancer |

Figura 5-20. Informacidn sobre upright
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Figura 5-21. Upright

-Arm: es una de las partes mas reconocidas y caracteristicas del Citroén 2CV. A lo largo
de los afios, pese a la evolucion de la geometria de las suspensiones, esta parte no se ha
modificado aparentemente. Dicha pieza tiene la funcion de unir las ruedas con los muelles.

E_.,

~ e T
| - -
| = T

Figura 5-22. Brazo de la suspension frontal del 2CV. Ref [25]

La Geometry de esta pieza esta formada por diferentes barras y elipsoides, reproduciendo
como disefio final en Adams la figura 23.

Figura 5-23. Arm
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Como podemos observar la modelizacion realizada en Adams no es exactamente como en la
realidad, puesto que no posee una potente herramienta gréfica que nos permita crear piezas
con formas tan complejas. En la hipdtesis de nuestro modelo del 2CV utilizaremos esta

geometria con su respectiva informacién incorporada en la figura 24.
Wl Modify General Part >

General Part |L_suspensiun_ﬁunlal.gel_arm

Type = left ¢ right ¢ single
Location Dependency | Centered between coordinates j
Centered between |Twc| Coordinates j

Coordinate Reference #1 _suspension_frontal ground.hpl_wheel_to_arm

_suspension_frontal_ ground_hpl_arm_1

Coordinate Reference #3

[
Coordinate Refarence #2 |

I

I

Coordinate Reference #4

Orientation Dependency |Orier1t axis along line j

Coordinate Reference #1 |,7suspensinniﬁnntal,grnund,hpliwheelitniarm

Coordinate Reference #2 |,_suspensinn_FrnntaI,grnund,hpl_arm_1

Axis " 7 X

Mass| 9 945804572 [100.0 Sprung Mass %

boc| 9.0190986432 [~ Off-Diagonal Terms
lyy| 3.69855595¢
lzz| 4. 382457262

CM Location Relative to Part |265,1 9006811656_-93.9960909915 563 4958357
Density = Maternal ¢ User Entered
Material Type | _materials_steel B |

Figura 5-24. Informacidn sobre arm

-Tierod: tiene como misidn transmitir el movimiento de direccidn a la rueda.

W Modify General Part X
General Part ‘L_suspeﬂs\nn_ﬁnma\,gel_tiernd

Type & left ¢ right ¢ single

Location Dependency ‘ Centered between coordinates j

Centered between ‘Twn Coordinates j

Coordinate Reference #1 ‘ __suspension_frontal.ground_hpl_tierod_outer
Coordinate Reference #2 ‘ __suspension_frontal_ground_hpl_tierod_inner

Coordinate Reference #3 ‘

Coordinate Reference #4 ‘

Orientation Dependency ‘Oriem axis along line j

Coordinate Reference #1 ‘ __suspension_frontal.ground_hpl_tierod_outer

Coordinate Reference #2 ‘ __suspension_frontal_ground_hpl_tierod_inner

Axis = 7Z X

Mass | 1.47868184¢ [000  sprung Mass %
boc| 4.7612490212 [~ Off-Diagonal Terms
lyy| 4. 761249022
12z | 71.80344642

CM Location Relative to Part ‘ 0.0,0.0,0.0
Density + Material © User Entered
Material Type _materials_steel

oK | Apply | Cancel |

Figura 5-25. Tierod Figura 5-26. Informacidn sobre tierod
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Bar_front: es la barra que comunica el brazo de la suspensién con los muelles.
En las siguientes figuras podemos observar una imagen real de la barra, como ha sido
modelada en Adams Car y su respectiva informacién para crearla.

W) Modify General Part =
General Part ‘L_suspensiUn_frumal.gel_bar_frum

Type & left € right © single

Location Dependency ‘Camerad between coordinates j

Centered between |Twu Coordinates j

Coordinate Reference #1 | _suspension_frontal.ground.hpl_arm_3

Coordinate Reference #3

Coordinate Reference #2 | ._suspension_frontal_ground.hpl_spring_1

Coordinate Reference #4

Orientation Dependency ‘Onem axis along line j

Coordinate Reference #1 | __suspension_frontal ground hpl_arm_3

Coordinate Reference #2 | ._suspension_frontal.ground.hpl_spring_1

Axis w7 X

Mass| 0 263453302 [1000  Sprung Mass %

boc| 4306 86518C ™ Off-Diagonal Terms
lyy | 4306 86518C
lzz| 3.19826321¢

CM Location Relative to Part |0_0,0_0,0_0
Density & Material  User Entered
Material Type _materials_steel

=

oK | Apply | Cancel |

Figura 5-27. Bar_front Figura 5-28. Informacion sobre bar_front

Figura 5-29. Bar_front
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-Spring: estd compuesta por el muelle y amortiguador. Para realizar la modelizacidn
del amortiguador se ha tomado como hipdtesis que su localizacion es la misma que bar_front.
En la realidad esto no es del todo cierto puesto que ambas estan situadas paralelamente, pero
el principio de funcionamiento del sistema es el mismo. Respecto a las propiedades del muelle
y amortiguador, en principio se utilizardn los Property Files implementados en Adams Car.
Posteriormente, dado que la suspensién del 2CV presenta diversas diferencias respecto a las
convencionales, serd necesario modificar estos archivos para obtener un comportamiento
similar a la realidad. En las siguientes figuras podemos apreciar el sistema montado en el 2CV,
ademas de la implementacion en Adams y su respectiva informacion.

W Modify General Part x

General Part ‘Lsuspenslonjrontal.gelisprmg

Type & left € right € single
Location Dependency ‘ Centered between coordinates j
Centered between |Twn Coordinates j

Coordinate Reference #1 | __suspension_frontal ground hpl_spring_1

Coordinate Reference #2 | __suspension_frontal ground hpl_spring_2

Coordinate Reference #3 |

Coordinate Reference #4 |

Orientation Dependency ‘ User-entered values j
Orient using * Euler Angles " Direction Vectors
Euler Angles [00. 0000

X Vector [100000

7 Vector [00.0010

MSSS‘ 10 |1[][],[] Sprung Mass %
ko) 1.0 [ Off-Diagonal Terms
Iyy|1.0
lzz|41.0

CM Location Relative to Part | 0.0,0.0.00

Density ' Material © User Entered

Material Type .materials.steel

OK | Apply | Cancel ‘

Figura 5-30. Amortiguador Figura 5-31. Informacién sobre spring

Para crear las fuerzas y, a su vez, las geometrias de los muelles y amortiguaciones,
seleccionaremos Build -> Forces -> Spring/Damper -> New. Posteriormente, introduciremos los
valores caracteristicos de nuestro modelado, quedando finalmente la General Part tal y como
se observa en la figura 5-32.

Figura 5-32. Spring
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Durante la modelizacidn de modelos en Adams Car, puede darse la situacién de que
necesitemos comunicar diferentes plantillas entre si. Mediante Mount Parts, Adams Car nos
permite realizar montajes entre diferentes plantillas, introduciendo la localizaciéon y el Minor
Role del montaje.

Para crear Mount Parts, debemos seleccionar Build -> Parts -> Mount -> New. En el caso
particular de nuestro Citroén 2CV, necesitamos realizar diversos montajes como pueden ser las

uniones de los muelles y los brazos al chasis o las barras de direcciéon a la columna de
direccidn, la cual se encuentra ubicada en otra plantilla. Particularizando, los siguientes Mount

Parts han sido creados en nuestro modelo:

Wl Modify Mount Part x
Mount Name | __suspension_frontal mtr_spring_to_body
Coordinate Reference |L_suspensiun_frnntal.grnund_hpr_spring_.?

From Minor Role |inherit j

OK | Apply | Cancel

Figura 5-33. Mount Part spring_to_body

@ Medify Mount Part ¥
Mount Name | __suspension_frontal.mtr_arm_to_body
Coordinate Reference |L_suspensil:un_frl:untaI.grl:uunl:l.hpr_arm_E
From Minor Role |inherit j

Ok | Apply | Cancel

Figura 5-34. Mount Part arm_to_body

w Modify Mount Part ¥
Mount Name | __suspension_frontal.mtr_tierod_to_steering
Coordinate Reference | ._suspension_frontal.ground_hpr_tierod_inner

From Minor Role |inherit j

OK | Apply | Cancel

Figura 5-35. Mount Part tierod_to_steering

Ademas, tal y como veremos mas adelante en el apartado Comunicadores, al crear Mount
Parts automaticamente se crean sus respectivos comunicadores Input.
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Una vez creadas las diferentes General Parts del sistema, es necesario realizar las uniones
entre si. Para ello, Adams Car cuenta con un amplio catdlogo de uniones o joints, entre las
cuales encontramos pares de revolucid, cilindricos, esfericos...

Para realizar uniones, seleccionaremos en el menu Build -> Attachments -> Joint -> New y se
abrird una ventana donde podremos crear las diferentes uniones de nuestro sistema.

Particularizando el caso para nuestro Citroén, en esta plantilla hemos creado las uniones
expuestas en la figura 36. Ademas, en la figura 37 podemos observar donde estdn ubicadas en
nuestro modelado.

- Attachments

=+ Joints

~ @hjorrev_upright_spindle

@ jolrev_upright_spindle
~s3jorcon_tierod_inner

-~ =3iolcon_tierod_inner
—g@jorhoo_spring_to_frame
~g@@jolhoo_spring_to_frame
-~ jorcyl_spring

— @ jolcyl_spring

- @hjorrev_bar front_to_arm
- @@jolrev_bar_front_to_arm
g4 jorcyl_arm_to_body

— @ jolcyl_arm_to_body

~ 9 jorsph_tierod_to_upright
- @ jolsph_tierod_to_upright
~@hjorrev_arm_to_upright

- @@jolrev_arm_to_upright

Figura 5-36. Joints utilizados en el modelado del 2CV
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Figura 5-37. Parte lateral de suspensién_frontal con sus General Parts y respectivas Joints

Cabe destacar que aquellas uniones o Joints que unan General Parts de diferentes plantillas se
deberan crear introduciendo sus respectivas Mount Parts.

Un ensamblado esta creado por diversos subsistemas. A su vez, los subsistemas se crean a
partir de las plantillas. Por lo tanto, resulta necesaria la comunicacién entre los diversos
subsistemas para un correcto ensamblado y funcionamiento. Para ello, el software ha creado
los Communicators que, tal y como su nombre indica, sirven para comunicar los diferentes
subsistemas entre si.

Existen multitud de Communicators en Adams Car, los cuales los podemos encontrar en las
diferentes plantillas que ofrece su catalogo. Para el correcto funcionamiento del ensamblado,
uno de sus subsistemas debe poseer un Communicator Input (entrada) y otro Communicator
Output (salida) relacionados entre si entre sus diferentes subsistemas. Existen una gran
variedad de funciones entre los Communiator como pueden ser array, location, mount, joint...

Para crearlos, deberemos ir a Build -> Communicators -> Input/Output -> New, donde
introduciremos los diferentes valores oportunos para nuestro modelo.

Debido al extenso nimero de Communicators que posee nuestro modelado y dado que este
proyecto no es un tutorial sobre Adams Car, solamente nombraremos los Communicators que
posee nuestra suspension. Para mas informacién acerca de ellos, solamente debemos
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seleccionar Help -> Adams Car Help en la barra de herramientas. En la figura 5-38 podemos
encontrar los que posee nuestra template suspension_frontal.

=- Communicators
=+l Input

icor_halfshaft_outer
3col_halfshaft_outer
icor_spindle
3col_spindle
3cor_drive_shaft_otr
3col_drive_shaft_otr
cor_wheel_center
3col_wheel_center
3cor_toe_angle
icol_toe_angle
cor_camber_angle
3col_camber_angle
3cor_suspension_upright
3col_suspension_upright
3cos_driveline_active
cor_suspension_mount
3col_suspension_mount
3cos_suspension_parameters ARRAY

Figura 5-38. Communicators de suspension_frontal del 2CV
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Tras crear la plantilla con todas las diferentes partes que la componen, es necesario crear un
subsistema de la suspension frontal.

Para ello, utilizaremos Adams Car en su versién Standard Interface. Para crear el nuevo
subsistema, deberemos seleccionar File -> New -> Subsystem. Seguidamente, introduciremos
el nombre del subsistema que queremos crear, en este caso suspension_frontal_c2cvy
seleccionaremos como Minor Role: front.

5.3 Suspension trasera

Para realizar la modelizacion de a suspensién trasera, partiremos de la plantilla
suspension_frontal, puesto que ambas son muy similares exceptuando ciertas partes.
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En primer lugar, modificaremos la geometria y las uniones entre arm y upright, puesto que
como podemos observar en la siguiente figura, el brazo de la suspensién trasera es diferente al
de la frontal.

Figura 5-39. Brazo trasera de la suspension del 2CV. Ref [26]

5.3.2 Modelizacién de la suspension trasera

En primer lugar, abriremos el template creado anteriormente suspension_frontal, el cual
guardaremos con el nombre de suspension_trasera.

A continuacion, modificando los valores de los hardpoints, realizaremos una suspensién
simétrica a la frontal y la ubicaremos en su posicidn real. Cabe destacar que algunos se
reubicaran en una nueva posicion para realizar un modelo mas parecido a la realidad. Los
hardpoints modificados en nuestro modelo quedaran tal que:

@ Hardpoint Madification Table X

loc_x loc_y loc_z

hpl_arm_1
hpl_arm_2
hpl_arm_3
hpl_center_upright
hpl_drive_shaft_inr
hpl_lwr_circle_upright
hpl_spring_1
hpl_spring_2
hpl_tierod_inner
hpl_tierod_outer
hpl_top_circle_upright
hpl_wheel_center
hpl_wheel_to_arm

Figura 5-40. Hardpoints de suspension_trasera
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Seguidamente, eliminaremos las barras de direccion anteriormente llamadas tierod y sus
respectivas Joints y Mount Parts, puesto que la suspensién trasera no las posee.

Por lo que a la suspensidn trasera respecta, solamente sera necesario modificar las diferentes
uniones entre las barras, quedando la plantilla como podemos observar a continuacién.

Figura 5-41. Parte lateral de suspension_trasera con sus General Parts y respectivas Joints

Cabe destacar que, tal y como hemos mencionado en el apartado Consideraciones Iniciales, se
ha modificado la geometria de arm y upright. Ademas, se ha substituido su anterior par de
union de revolucién por un par fijo, tal y como se ha considerado tras su comparacion con la
realidad.

Finalmente, tal y como se ha creado anteriormente, realizaremos un subsistema basado en la
template suspension_trasera, la cual crearemos con Minor Role: rear y nombraremos
suspension_trasera_c2cv.
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5.4 Motor y caja de cambios

A lo largo de los afios, desde el primer Citroén 2CV el cual producia una potencia maxima de
9CV, la motorizacidn del vehiculo ha ido evolucionando hasta llegar a un total de 26CV que
imprimia su modelo 2CV 4.

Tal y como se describié anteriormente, el 2CV es un vehiculo que en sus diferentes versiones
era de traccidn delantera, exceptuando su modelo 4x4 el cual incluia motorizacidn trasera.

Tal y como podemos ver en el Anexo Il, el modelo 2CV 4 posee un motor de 435cc con una
potencia mdxima de 26 CV y un par de 3.1 mKg. Lo cilindros de dicho motor estan situados
transversalmente resecto al vehiculo y opuestos entre si.

Figura 5-42. Motorizacion de nuestro Citroén 2CV

Respecto a la caja de cambios, el 2CV 4 posee 4 velocidades y la marcha atras, siendo sus
relaciones aproximadamente 6.71:1 para la 12 marcha, 3.23:1 parala 23,1.93:1 parala32y
1.47 para la 42. La marcha atras es aproximadamente de 7:1. Estos valores se han obtenido
tras realizar la desmultiplicacién de un diferencial cénico 8:31 a los valores expuestos en el
Anexo Il.

Respecto a las curvas del motor, no hemos encontrado gréficas de nuestro vehiculo, por lo que
realizaremos una aproximacion de ellas hasta obtener unos valores aceptables.
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Para realizar la modelizacion del motor y la caja de cambios de nuestro vehiculo, partiremos
del subsistema engine_transmission_transverse, el cual podemos encontrar en el catdlogo
concept de Adams Car. Este subsistema forma parte del vehiculo Sedan de Adams Car.

Para cargar el subsistema, en el modo Standard Interface mediante File -> Open -> Subsystem
abrimos el subsistema correspondiente.

Una vez cargado el subsistema, modificaremos las curvas y las caracteristicas del motory la
caja de cambios para hacerlo mas similar a nuestro automovil. Para ello, accedemos al menu
Adjust -> Powertrain Properties y seleccionamos Manual Gear Shifting, puesto que la
transmisién de nuestro vehiculo es manual. Los valores introducidos para nuestro modelo son
los siguientes:

L
Powertain Configuration |I‘u‘13nua| Gear Shifting j

Engine ] Clutch  Transmission l
Number of Gears | 04 v
Gear Shift Points v Individual (Gear-Specific)

Gear Number |R |N |[]1 |[]2 |[]3 |[]4
Gear Ratio |70 [oo Jem2 [323 |193 [147
Shift-Down [rpm] [750.0 | 1000.0 | 1200.0 | 1200.0
Shift-Up [rpm] | 5500.0 | 5500.0 | 5800.0 [ £750.0

Power/\elocity Plot OK | Apply | Close

Figura 5-43. Relaciones de transmision del 2CV

Powertrain Power/Velocity - Gear Map
40.0

20,0+

Transmission Output Power [PS]

0.0

00 200 400 60.0 80.0 100.0 120.0
Vehicle Velocity [kph]

Figura 5-44. Curvas Potencia-Velocidad del 2CV

Finalmente, guardaremos el subsitema como _motor_c2cv, introduciendo front como Minor
Role de nuestro subsistema.
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5.5 Direccion

Para modificar la trayectoria del vehiculo y seguir el rumbo deseado, es necesario un sistema
capaz de guiar el automovil. Asi pues, conocemos como direccidon de un automavil el sistema
gue permite orientar las ruedas directrices del vehiculo.

Mediante la accidn del conductor, el sistema de mecanismos que forma la direccién actua
sobre las ruedas. Existen diferentes tipos de direcciones dependiendo de su configuracion en
la unidn entre varillaje y columna de direccidn, tales como por ejemplo los sistemas pifion
cremallera.

En nuestro Citroén 2CV se monta una direccién “rack and pinion” conocida como pifion
cremallera.

1
T T,
4aB+“3.442_1079315

Figura 5-45. Sistema pifion cremallera del 2CV. Ref [27]

Para realizar la modelizaciéon de la direccidn del 2CV, crearemos una template copia de la
guardada en catalogos _rack_and_pinion_steering, la cual nombraremos como _direccion y
otorgaremos un Minor Role: front. Posteriormente, realizando el cambio a la versién Standard
Interface, crearemos un subsistema a partir de dicha template con el nombre _direccion_c2cv
con Minor Role: front, puesto que queremos que se ubique en la parte frontal del vehiculo.

Tras crear el nuevo subsistema, puesto que ya posee todos los Communicators y Mount Parts
necesarios para ensamblarse con los otros subsistemas, solamente deberemos modificar los
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hardpoints para darle una geometria similar a la real. En nuestro caso, las ubicaciones de los
hardpoints son las siguientes:

W Hardpoint Modification Table X
" Assembly * Subsystem |primer_motor.direccion_2cv j Name Filter: ,*7
loc_x loc_y | loc_z |

hpl_rack_house_mount 050.0 -400.0 400.0 (none)
hpl_tierod_inner 1050.0 -50.0 400.0 {none)
hps_intermediate_shaft_forward |1250.0 -300.0 600.0 (none)
hps_intermediate_shaft_rearward |1400.0 -300.0 1000.0 (none)
hps_pinion_pivot 1050.0 -300.0 400.0 (none)
hps_steering_wheel_center 1650.0 -300.0 1050.0 (none)

| | D]

Display: Single and | Left  Right ¢ Both 0K | Aply | cancel |

Figura 5-46. Hardpoints del subsistema de la direccion del 2CV
Como podemos observar, la ubicacidn de los hardpoints nombrados tierod_inner coincide con

la ubicacidn de los mismos en el subsistema suspension_frontal _c2cv.

Finalmente, deberemos guardar el subsistema de la direccion en nuestra base de datos para
usarlo posteriormente en el ensamblado del vehiculo.

Figura 5-47. Subsystem _direccion_2cv

5.6 Ruedas frontales y traseras

Uno de los elementos mas importantes en un vehiculo son las ruedas, ya que constituyen el
Unico elemento de unién entre el vehiculo y la calzada, por lo que estas forman parte del
sistema de transmision de potencia, direccidn y suspension. La rueda es un conjunto formado
por el disco y la llanta metalica del vehiculo, el cual estd unido mediante uniones mecdnicas a
la transmisidén o giran libremente, dependiendo de si son motrices o no. También, uno de sus
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elementos son los neumaticos, los cuales se alojan sobre las llantas y deben estar en contacto
permanente con el suelo.

Principalmente, las ruedas tienen la funcion de:
- Transmitir la potencia motriz del motor a la calzada.
- Soportar las diferentes cargas del vehiculo.
- Contribuir y estabilizar el vehiculo durante la frenada.
- Mejorar la eficacia de la suspensidn.
- Generar y transmitir las fuerzas laterales necesarias para realizar giros en las curvas.
- Asegurar y mantener la direccién del vehiculo en su trayectoria.

Con la evolucidn del ser humano, las ruedas han tendido a reducir su didmetro y aumentar su
anchura para ofrecer mayor estabilidad y bajar el centro de masas del vehiculo. En nuestro
modelo del 2CV, podremos observar como las ruedas presentar varias diferencias respecto a la
actualidad, puesto que montan unos neumaticos de gran didmetro y poca anchura.

La nomenclatura de los neumaticos de nuestro modelo es 135 R15 72S. Esta nomenclatura
estd un poco obsoleta, puesto que no nos indica la relacion de aspecto del vehiculo. Es
habitual encontrar modelos del 2CV con neumaticos 125/15 dado que las leyes permiten su
uso.

Para modelizar las ruedas delanteras y traseras de nuestro vehiculo utilizaremos un proceso
diferente a los anteriores, puesto que las modificaremos a partir de los archivos de texto que
crea Adams Car sobre los subsistemas.

En primer lugar, abriremos las plantillas de cualquier tipo de ruedas similares a las nuestras. En
nuestro caso hemos utilizado las plantillas _handling_tire. Seguidamente, guardamos el
archivo en primer lugar como _front_wheels_2cv, que tal y como su nombre indica seran las
ruedas delanteras del vehiculo. Seguidamente, repetimos el proceso para las ruedas traseras.

Una vez creadas las dos plantillas de las ruedas frontales y traseras, procederemos a crear los
subsistemas respectivos, dandoles como Minor Role: front y rear para las ruedas frontales y
traseras respectivamente.

Seguidamente, en el menu Browse de Adams Car, abrimos el submenu Force Elements -> Tires
-> tir/til_wheel y abrimos la ruta del archivo Property File, el cual posee las propiedades del
neumatico.

Una vez abierto el archivo .tir con un editor de textos, modificaremos los parametros
necesarios para variar la geometria y propiedades de las ruedas. En nuestro caso, los
parametros que hemos modificado son los siguientes:
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[DIMENSION]
UNLOADED_RADIUS =380
WIDTH =125
ASPECT_RATIO =0.8

S vertical

[PARAMETER]
VERTICAL_STIFFNESS  =315.0
VERTICAL_DAMPING =3.1
LATERAL_STIFFNESS  =190.0
ROLLING_RESISTANCE =0.0

El resto de pardmetros los hemos dejado de serie, puesto que es informacién que no hemos
podido obtener sobre nuestro modelo. Una vez modificado el archivo y guardado, podemos
guardar el subsistema de las ruedas.

El proceso utilizado ha sido el mismo tanto para las ruedas frontales como para las traseras.
Ademas, los valores de ambas son iguales.

» ©

Figura 5-48. Subsistema ruedas_delanteras_2CV

5.7 Sistema de frenos

Por su propia naturaleza, la rueda una vez empieza a rodar tiende a seguir dicho movimiento.
Por tanto, es necesario el invento del freno para poder controlar el movimiento de la rueda
para asegurar la detencidn de las mismas. El principio de los sistemas de frenado radica en una
pieza la cual se presiona contra la rueda y mediante friccion logra detener o reducir su
movimiento. Podemos considerar entonces que los frenos son transformadores de energia, ya
que transforman la energia cinética que posee la rueda en calor mediante friccion.
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En la actualidad existen varios tipos de frenos dependiendo de su geometria y funcionamiento.

En primer lugar, podemos encontrar los frenos de tambor los cuales monta nuestro modelo
2CV. Este sistema de frenado estd constituido por un tambor montado sobre el buje de la

S

P ]

- Tambor
- Zapata o mordaza primaria
- Zapata o mordaza secundaria
.- Dispositivo de retencion lateral de las mordazas
- Soporte de articulaciones
Bombin de doble piston
.= Muelles de retorno

1.
2.
3.
4

5.
6.
7

Elementos que forman un tambor de freno

Figura 5-49. Frenos de tambor. Ref [28]

rueda mediante esparragos y tuercas, y por un plato de freno, que es el elemento fijo sujeto al
puente o a la porta mangueta. En este plato podemos encontrar las zapatas, las cuales estdn
recubiertas de unos forros que son los elementos de friccion.

Ahora bien, en la actualidad los frenos mas utilizados son los conocidos como frenos de disco.
Su principal ventaja respecto al freno de tambor es que posee un menor tiempo de frenado, lo
gue se traduce como una menor distancia de parada. Este hecho radica en que los dispositivos
de friccion estan montados al aire, por lo que al disponer de una mayor refrigeracion la
absorciéon de energia y su transformacidn en calor se puede realizas mas rapidamente.

Estos frenos estdn compuestos por tres elementos basicos, los cuales son el disco, las placas de
friccidn y las abrazaderas. El disco gira solidariamente con el eje de la rueda y se encuentra
entre las abrazaderas. Mediante el sistema de frenado se aplica una fuerza en las abrazaderas,
las cuales empujan las placas de friccidn y entran en contacto con el disco, sobre el cual
ejercen el esfuerzo provocado. El efecto de esta fricciéon produce el par de frenado sobre la
rueda.

Como hemos dicho en el apartado anterior, nuestro modelo del 2CV monta un sistema de
frenado de tambor. Ahora bien, en el catdlogo de Adams Car solamente hemos encontrado
sistemas de frenado de disco y desconocemos el método para crear frenos de tambor. Asi
pues, tomaremos la hipétesis de que nuestro vehiculo posee frenos de disco y trataremos de
modificarlos para que tengan un comportamiento lo mds cercano posible a la realidad.
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En primer lugar, partiremos directamente de cualquier subsistema de frenos que encontremos
en el catdlogo de Adams. En nuestro caso, hemos cargado los frenos que monta el ejemplo
Sedan cuyo nombre es sedan_brake_system.

Posteriormente, modificaremos los parametros que encontramos en el menu Browse ->
Parameter Variable. En nuestro caso, hemos modificado los tamafios del pistén, las areas, el
valor maximo de frenado y los coeficientes de rozamiento hasta que nuestro vehiculo se
detenia de 100 km/h a 0 en unos 12-15 segundos aproximadamente. Tal y como hemos dicho
anteriormente, la suposicidon de que nuestro vehiculo monta discos de freno hace compleja su
modelizacidn, puesto que debemos ir ajustando a base de pruebay error los valores de los
pardmetros de los frenos.

Finalmente, tras modificar el subsistema del Sedan, guardaremos el subsistema en nuestra
base de datos, en nuestro caso con el nombre _frenos_2cv, con un Minor Role: any.

Figura 5-50. Subsistema frenos_2CV del 2CVY

5.8 Driveline

El driveline o palier es uno de los elementos mas importantes de un vehiculo, puesto que es el
encargado de transmitir el movimiento desde la salida del diferencial hasta las ruedas,
permitiendo la correcta funcién tanto de la suspensién como de las ruedas.

Normalmente, las suspensiones implementadas en Adams Car ya poseen incorporados los
drive_shafts (palier). En nuestro caso, dado que hemos creado la suspensién completamente,
decidimos utilizar las plantillas _driveline que ofrece Adams para aquellas suspensiones que no
incorporen estas barras. Para implementarlas en nuestro vehiculo, en primer lugar, partiremos
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del subsistema _driveline_fwd el cual va montado en el vehiculo Sedan, Unico ejemplo de
vehiculo de traccidn delantera que hemos encontrado en el programa.

Tras abrir el subsistema, solamente deberemos modificar los hardpoints para que se ubique en
su sitio, puesto que las partes de montaje Mount Parts ya fueron incorporadas en los otros
subsistemas anteriormente.

“

™ Assembly * Subsystem |pr|mer7m0tur.dnve\lnechcv j MName Filter: l’i
loc_x loc_y loc_z | remart

hpl_inner_CVJ IR -400.0 350.0 (nane)

hps_diff_mount |680.0 -200.0 350.0 (none)

] | 0]

Display: Single and ® Left  Right  Both oK | Apply | Cancel |

Figura 5-51. Hardpoints del subsistema _driveline_c2cv

Finalmente, guardaremos el subsistema con su respectivo nombre _driveline_c2cvy, dado que
irda montado en la parte frontal del vehiculo, seleccionaremos front en el campo Minor Role.

Figura 5-52. Driveline_c2cv

51



UNIVERSIDAD POLITECNICA DE VALENCIA
.lllll.

Escuela Técnica Superior de Ingenieria del Diseio

6. ENSAMBLADO DE LAS SUSPENSIONES Y VEHICULO

6.1 Introduccion al ensamblado

Para realizar el andlisis de un automovil o de una suspension, es necesario crear un assembly.

Tras realizar todos los subsistemas que componen nuestro modelo, en la versidn Standard de
Adams Car, realizaremos el ensamblado de la suspensién frontal junto a la direccidn y los
palieres para analizar su comportamiento. Posteriormente, repetiremos el proceso para la
suspension trasera vy, finalmente, ensamblaremos el vehiculo completo en su totalidad.

6.2 Ensamblado de la suspensién delantera

En la version Standard Interface seleccionaremos File -> New -> Suspension Assembly.
Seguidamente, nos aparecera una ventana como la que se muestra a continuacion donde
deberemos introducir los subsistemas que la forman. En nuestro caso, el assembly de la
suspension delantera estard formado por la suspensién _suspension_frontal c2cv, direccion
_direccion_2cvy driveline _driveline_c2cv. Este ensamblado no nombraremos como

_full front suspension_c2cv.

Wl New Suspension Assembly X
Assembly Name ‘ful\_ﬁunt_suspensmn_ch\‘{
Suspension Subsystem ‘ suspension_frontal_c2cv j
Iv Steering Subsystem J‘ mdids://Citroen2CV/subsystems tbl/direccion_2cvsub
¥ Other Subsystems )| =ids://Citzoen2Cy/ subsystems . thl/driveline_c2cv. sub

=
Suspension Test Rig |__MDI_SUSPENSION_TESTRIG -

Populate

OK ‘ Apply | Cancel |

Figura 6-1. Creacion del assembly full_front_suspension_c2cv

Tras realizar en ensamblado, nos aparecera en pantalla el disefio en 3D de nuestro
ensamblado, tal y como podemos observar en la figura 6-2.

Figura 6-2. Assembly _full_front_suspension_c2cv
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Finalmente, guardaremos el ensamblado de la suspensidn frontal para realizar el andlisis
dindmico posteriormente mediante File -> Save As -> Assembly, ubicandolo en nuestra base de
datos.

6.3 Ensamblado de la suspensidén trasera

Para realizar el ensamblado de la suspension trasera de nuestro Citroén 2CV, seguiremos el
proceso anteriormente explicado.

En este caso, solamente utilizaremos el subsistema _suspension_trasera_c2cv, puesto que las
ruedas traseras de nuestro modelo no poseen sistema de direccién y es un vehiculo de
traccidn delantera, por lo que no le instalaremos palieres.

ﬂ Mew Suspension Assembly =
Assembly Name |ﬁ.|||_rear_suspensiunj:2cv
Suspension Subsystem | suspension_trasera_cZ2cv j

[~ Steering Subsystem J|
[ Other Subsystems

Suspension Test Rig | __MDI_SUSPENSION_TESTRIG -

F'Dpulate| DK Apply ‘ Cancel ‘

Figura 6-3. Creacion del assembly _full_rear_suspension_c2cv

De la misma forma que con la suspensién frontal, aparecerd en pantalla el disefio 3D del
assembly full _rear _suspension_c2cv el cual guardaremos para su posterior analisis en nuestra
base de datos.

Figura 6-4. Assembly _full_rear_suspension_c2cv

6.4 Ensamblado del vehiculo Citroén 2CV

Finalmente, procederemos a realizar el ensamblado completo de nuestro vehiculo Citroén
2CV.

Para crear el Assembly, en la barra de herramientas seleccionaremos File -> New -> Full-Vehicle
Assembly. Aparecera una ventana donde se indican los subsistemas necesarios a incorporar
para realizar el ensamblado completo del vehiculo. En nuestro caso, nuestro vehiculo
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incorporara todos los subsistemas mencionados en el capitulo anterior, tal y como podemos
observar en la siguiente figura.

@ Mew Full-Vehicle Assembly X
Assembly Name |f|.|||_c:2c:\,1

Front Susp Subsystem | suspension_frontal_cZcv j
Rear Susp Subsystem E | suspension_trasera_cZcy j
Steering Subsystem E | direccion_2cv j
Front Wheel Subsystem E | ruedas_delanteras j
Rear Wheel Subsystem E | ruedas_traseras j
Body Subsystem E | body 2cv j
|v Brake Subsystem E |fren05_2w j
v Powertrain Subsystem E | moator_cZcv j
[v Other Subsystems ]

;I' -driveline cZcw

Vehicle Test Rig |__MDI_SDI_TESTRIG -

Populate OK ‘ Apply | Cancel ‘

Figura 6-5. Creacion del assembly _full_c2cv

En nuestro caso, todos los subsistemas estan posicionados en su respectivo lugar. Si no fuese
el caso, solamente tendriamos que modificar la ubicacién o los hardpoints de los subsistemas
para dar una forma correcta al vehiculo.

Figura 6-6. Assembly _full_c2cv
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7. SIMULACION DINAMICA DE LAS SUSPENSIONES Y VEHICULO
CITROEN 2CV

7.1 Introduccién a la simulacién dinamica

Utilizando la herramienta de simulacion dinamica que ofrece el software Adams Car,
analizaremos el comportamiento dindmico de los ensamblajes que hemos creado
anteriormente. Dado que los modelos creados no dejan de ser una aproximacién a los modelos
reales del vehiculo, pretenderemos obtener unos resultados coherentes en la simulacién
dindmica. Ademds, esta herramienta nos ayudara a realizar un modelo mas parecido a real,
puesto que como dijimos en anteriores apartados hay subsistemas que se han modelizado
mediante prueba-error.

A lo largo de este capitulo, realizaremos analisis mediante una serie de pruebas del vehiculo
Citroén 2CV, asi como de sus sistemas tan peculiares de suspension. Ademas, comentaremos
los resultados obtenidos para analizar su coherencia y que se aproximen a la realidad.

Adams ofrece un amplio abanico de analisis para nuestros ensamblados y realizar todos
provocaria un aumento considerable de la extensidn del proyecto, por lo que realizaremos los
analisis principales para cada ensamblado.

7.2 Simulacion dindamica de la suspension frontal

Para realizar cualquier andlisis de un Assembly, necesitaremos abrir el archivo en Standard
Interface del software Adams Car. Para ello, en el menu seleccionaremos File -> Open ->
Assembly y, en este caso, seleccionaremos el assembly _full front suspension_c2cv. Tras
cargar el ensamblado, procederemos a realizar el analisis del comportamiento de la
suspension.

Para realizar un andlisis, seleccionaremos en la barra de herramientas Simulate -> Suspension
Analysis y seleccionaremos el deseado, en nuestro caso, Parallel Travell.
Wl Suspension Analysis: Parallel Travel x

Suspension Assembly |fuII_frUnt_suspension_chv j

Output Prefix | Parallel_Travel Front
Number of Steps |2p[]

Maode of Simulation ’W‘
Vertical Setup Mode |Whee| Center j
Bump Travel | 50

Rebound Travel | 50

Travel Relative To |Whee| Center j
Control Mode f+ Absolute  Relative

Fixed Steer Position |
Steering Input f« Angle © Length

[v Create Analysis Log File

= .. :
Figura 7-1. Parametros del andlisis Parallel Travel
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Una vez realizado el analisis, Adams Car nos ofrece distintas herramientas para evaluar el
comportamiento de nuestro ensamblado. Como herramienta principal, tenemos el
PostProcessor, mediante el cual podemos obtener gréficas del comportamiento dindmico. Si
gueremos ver una animacion de lo sucedido, utilizaremos la herramienta de animaciones
Animations Controls.

Para abrir el PostProcessor, en la barra de herramientas seleccionaremos Review ->
PostProcessing Window.

Una vez abierto, seleccionaremos en la casilla Simulation la simulacién realizada y,
seguidamente, podremos obtener las graficas deseadas mediante las casillas Filter y Request.

Cuando describimos anteriormente, los dngulos de las ruedas influyen en la conduccién.
Realizaremos el analisis de los angulos de convergencia y caida cuando desplazamos la rueda
verticalmente.

0.5 =~ 50.0
testrig.camber_angle.right o L
- -testr_!g,tueiang\_e,nght ) i P L 400
----- testrig.wheel_travel vertical_right
- = e T [
. o F30.0
- K
- "4 .
- - "f
- R F20.0
0.0 ” — = L
_ e 100 =
om -
) - i E
4 - L r0.0 £
) e s I 5
E - - R 9
- s F-10.0
- ‘,' L
05 e
- i F-20.0
- Mg -
--30.0
=T 400
a0+~ ! | ! ! 500
0.0 50.0 100.0 150.0 200.0 250.0
Analysis: Parallel_Travel_Front_parallel_travel Time (sec)

Figura 7-2. Resultados del analisis Parallel Travel Front

Tal y como nos muestran las gréficas, los angulos de convergencia y de caida del neumatico
apenas varian de 0. Esta es una de las caracteristicas principales que posee nuestro modelo
Citroén 2CV, puesto que su geometria y el par de revolucion vertical que une la barra de
suspension a la rueda apenas permite la aparicién de estos angulos. Debido al movimiento que
implica el analisis, el desplazamiento vertical de la rueda varia linealmente, puesto que la
condicién del andlisis mueve el centro de la rueda entre los valores introducidos en las casillas
Bump Travel y Rebound Travel.

Este analisis consiste, a diferencia del anterior, en desplazar los centros de los neumaticos de
forma opuesta, por lo que esperamos que el comportamiento sea similar al anterior. Parra
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realizar el andlisis, seleccionaremos el modo de analisis Opposite Wheel Travel. Seguidamente,
introduciremos los mismos valores que en el apartado anterior para comparar los resultados.

0.5 7= 50.0
- testrig.camber_angle.right L
N — — -testrig toe_angle right
2 . i : . - 40.0
el | | e testrig.wheel_travel vertical_right
4 -.‘.\ . - B
. ~ F30.0
.y e
‘r‘ ""\ -
e ~ 200
0.0 - Ay L
<L ~.
. . ~1 -10.0 €
{=
§ e K S i £
o 7 e N 0.0 =
o e ~ L 2
é . \\ 3
s S F-10.0
. -~ |
0.5 M e -
. “ F-20.0
s N L
--30.0
. 400
10 | | | ™ 500
0.0 500 100.0 1580.0 200.0 250.0
Analysis: Opposite_Travel_Front_opposite_travel Time (sec)

Figura 7-3. Resultados del analisis Opposite Wheel Travel

Como podemos observar, ambas graficas son similares. La diferencia entre ellas radica en la
direccién del desplazamiento vertical de la rueda, puesto que en este segundo la rueda viaja
de arriba abajo, justo al contrario que en el analisis Parallel Travel Front.

Otro de los analisis necesarios para conocer el comportamiento de nuestro modelo es el de
direccion. Mediante este anadlisis, se comprueba como giran las ruedas mediante el giro de

cierto angulo del volante.

Para realizar el analisis, seleccionaremos en el menu de andlisis Steering y, seguidamente,
introduciremos los valores que observamos en la figura siguiente.

W@ Suspension Analysis: Steering X

Suspension Assembly |fulljrontisuspensionicECv j

Output Prefix
Number of Steps
Mode of Simulation
Vertical Setup Mode
Upper Steering Limit

Lower Steering Limit

|Steering|
[ 200

| 300
| -300

Left Wheel Fixed Height |

Right Wheel Fixed Height |

Travel Relative To
Control Mode
Steering Input

Coordinate System

Wheel Center -

@ Absolute © Relative

v Angle © Length

Vehicle ~| T

I¥ Create Analysis Log File

e

Ok | Apply | Cancel ‘

Figura 7-4. Parametros del anadlisis Steering
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300.0

steering_displacements.angle_front
- — — -testrig.toe_angle.right
----- testrig.camber_angle right

200.01

100.0 1

00

Angle {deg)

-100.0

-200.0 4

-300.0

T T T T
0.0 50.0 100.0 150.0 2000 2500
Analysis: Steering_steering Time (sec)

Figura 7-5. Resultados del andlisis Steering

En los resultados obtenidos mediante el PostProcesador, podemos observar como el volante
varia entre -300 y 300 grados su angulo, por lo que se ha aplicado correctamente la condicién
del analisis. Seguidamente, pese a la escala del grafico, podemos observar como el angulo de
caida es practicamente nulo como en los ensayos anteriores debido a la geometria de la
suspensidn. En cambio, si observamos la variacion del dangulo de convergencia/divergencia,
podemos observar como varia con el transcurso del ensayo tal y como impone la condicion del
giro del volante.

7.3 Simulacion dindmica de la suspension trasera

Siguiendo la misma metodologia utilizada para el andlisis de la suspensién delantera
trataremos de analizar el comportamiento de la suspension trasera. Debemos tomar como
consideraciones que estas ruedas no son ni motrices ni directrices, por lo que deberan tener
un comportamiento muy sencillo. Ademas, al igual que en la suspension frontal, los dngulos de
convergencia y caida no deberian variar considerablemente debido a la geometria de la
suspension.

Al igual que con la suspensién anterior, para realizar el analisis Parallel Travel seleccionaremos
en el menu Simulate -> Suspension Analysis -> Parallel Wheel Travel. En la ventana de
introduccion de pardmetros introduciremos los mismos valores que con la suspensidn frontal,
los cuales podemos observar en la figura 7-1.
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Figura 7-6. Resultados del andlisis Parallel Travel Rear

Como podemos observar, pese a que las ruedas se desplazan verticalmente, los angulos de
caida y convergencia se mantienen nulos. Esto se debe a que, en su modelizacién, se ha
utilizado un par fijo entre la suspension y la rueda tal y como es en la realidad. Cabe decir que
seguramente en la realidad existira cierto angulo debido al desgaste de la suspensién y que,
como hemos dicho varias veces, esto es una simple aproximacion al comportamiento real.

Del mismo modo que realizamos con la suspension delantera, realizaremos el ensayo Opposite
Travel para la suspension trasera. Para ello, introduciremos los mismos pardmetros que se
estan utilizando en el proyecto para poder comparar los resultados entre ellos.

Tras realizar el andlisis, obtenemos los siguientes resultados.

1.0 e 50.0
——testrig.camber_angle right B
— —testrig.toe_angle.right r40.0
===-testrig.wheel_travel.vertical_right F
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e 200
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., L
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e L
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Analysis: Opposite_Travel_Rear_opposite_travel Time (sec)

Figura 7-7. Resultados del andlisis Opposite Travel Rear

Tal y como sucedia en el apartado anterior, podemos observar como los angulos de caida y
convergencia se mantienen nulos a lo largo del recorrido de las ruedas, lo cual es el resultado
esperado para esta suspension.
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7.4 Simulacién dindmica del vehiculo completo

Tal y como hemos realizado en los apartados anteriores, para realizar la simulacién dindmica
del vehiculo sera necesario cargar el assembly correspondiente mediante el menu File -> Open
-> Assembly.

Al igual que para las suspensiones, existen varios ensayos para el vehiculo completo. Paraa
acceder a ellos, podemos hacerlo desde el menu Simulate -> Full Vehicle Analysis.

El primer andlisis que le realizaremos a nuestro modelo Citroén 2CV consistira en una prueba
de aceleracion.

Para realizar el analisis, navegaremos a través de Simulate -> Full Vehicle Analysys -> Straight-
Line Events -> Acceleration. Introduciremos las siguientes condiciones.

Wl Full-Vehicle Analysis: Acceleration X
Full-Vehicle Assembly |fu\|_02cv j
Output Prefix |Acce|eratiun
End Time | 30
Number Of Steps | 200

Simulation Mode interactive <

Road Data File $' L:.f.l’acarﬁsharedfroads.tbl.lejat.rdf

Steering Input straight line -

Initial Velocity B [kmvhr  ~|
Start Time | 1

Final Throttle | 100

Duration of Step | 1
Gear Position J,ﬁ

¥ Shift Gears
[w Quasi-Static Straight-Line Setup

[v Create Analysis Log File
£

Figura 7-8. Parametros del andlisis Acceleration

llll‘ oK ‘ Apply | Cancel |

Tras realizar el andlisis, analizaremos los resultados obtenidos para comprobar si nuestro
modelo es similar al real o no. Es por ello que necesitamos datos para comparar las
simulaciones, los cuales podremos encontrar en el Anexo Il del proyecto.

Seguidamente, abriendo el PostProcesador mediante Review -> PostProcessing Window
obtendremos las gréficas calculadas.
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Length {mm)

100000.0

0.0

-1.0E+05
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Analysis: Acceleration_accel Time (sec)

Figura 7-9. Analisis del desplazamiento del vehiculo. Simulacion Acceleration

En primer lugar, tal y como podemos observar, el vehiculo realiza % de milla en
aproximadamente unos 26 segundos. En la realidad, segun los datos de Citroén el vehiculo real
también los realiza en 26 segundos, por lo que es un resultado exitoso.

100.0

[ —chassis_'v'elocities.longitudinal|
90.0

80.0 1

70.0 H

60.0

50.0 H

Welocity (kmish)

40.0 H

20.0

20.0 1

10.0 1

0.0 T T T T y
0.0 50 10.0 15.0 200 250 300

Analysis: Acceleration_accel Time (sec)

Figura 7-10. Analisis de la velocidad del vehiculo. Simulacion Acceleration

Como podemos observar en las graficas de velocidad, nuestro vehiculo consigue alcanzar los
50 km/h en aproximadamente 10 segundos. Pese a ello, a los 30 segundos todavia no ha
logrado llegar a su velocidad maxima de aproximadamente 100 km/h.
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4.0

——transmission.gear_number_front

3.5

3.0+

2.5+
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2.0

1.0 T T T T T
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Analysis: Acceleration_accel Time (sec)

Figura 7-11. Analisis del cambio de marchas del vehiculo. Simulacién Acceleration

5000.0 rn

4 engine.output_rpm_front

4500.0

4000.0 4

3500.0
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Il

3000.0

2500.0 4

2000.0 4

1500.0 T T T T T
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Analysis: Acceleration_accel Time (sec)

Figura 7-12. Analisis del rpm del vehiculo. Simulacién Acceleration

En las graficas anteriores podemos ver cémo se comporta el motor y la caja de cambios del
vehiculo. Como observamos, el motor va aumentando las marchas conforme aumenta la
aceleracién hasta llegar a la cuarta velocidad, que es la maxima del vehiculo. Como podemos
observar, al realizar el cambio de marcha el rpm cae puesto que se produce un corto periodo
al desembragar y embragar.
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Adams Car nos ofrece también la oportunidad de realizar pruebas de frenado. Para realizar la
simulacidn de frenado, seleccionaremos la Simulate: Braking. Los parametros utilizados en la
prueba de frenado se exponen en la siguiente figura.

ﬂ Full-Vehicle Analysis: Braking >
Full-Vehicle Assembly | full_c2cv -
Output Prefix | Braking|

End Time 110

MNumber Of Steps | 100

Simulation Mode interactive h

Road Data File " L:Hacar_shared.-froads_tbl.-Qd_ﬁaerf

Steering Input |Straight line j
Initial Velocity |80 [kmmr  ~|
Start Time | 1

Open-Loop Brake j

Final Brake | 100

Duration of Step | 1

Gear Position 4 -

¥ Quasi-Static Straight-Line Setup

l¥ Create Analysis Log File

£
"
-~y

Figura 7-13. Parametros del andlisis Braking

lih‘ oK | Apply | Cancel |

Seguidamente, abriremos el PostProcessor para leer los resultados obtenidos.

80.0

chassis_veloc! .Iong\tudma\]

70.0 4

60.0

50.0 4

40.0 1

Velocity (kmih)

30.0 4

20.0

10.0 T T T T T
0.0 1.0 20 30 4.0 50 6.0 7.0 8.0 9.0 10.0
Analysis: Braking_brake Time (sec)

Figura 7-14. Andlisis de la velocidad del vehiculo. Simulacién Braking
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1.5E+05

chassis_displacements.longitudinal

100000.0

50000.0
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Figura 7-15. Analisis del desplazamiento del vehiculo. Simulacion Braking

Como podemos observar, el vehiculo pasa de 80 km/h a 10 km/h en 10 segundos. Esto es un

valor estimado puesto que desconocemos las mediciones reales del vehiculo, ademas que los
frenos han sido modelizados mediante prueba-error. Ademas, podemos observar como para

realizar la frenada el vehiculo se desplaza unos 125 metros aproximadamente, un valor poco

razonable ya que la informacion encontrada varia ente 80 y 90 metros.

0.0
frenos_2cv.brake_torgues.left_front
7 = =frenos_2cv.brake_torques:right_front
----- frenos_Bcv.brake_torques left_rear
-50000.0 + — = -frenos_Z2cv.brake_torques.right_rear
-1.0E+05 A
c ]
£
§ -1.5E+05
H
[
= 4
-2 0E+05 A
-2.5E+05 A
-3.0E+05 T T T T T T T T T
0.0 1.0 20 30 40 50 6.0 7.0 8.0 9.0 10.0
Analysis: Braking_brake Time (sec)

Figura 7-16. Analisis del par de frenado en el vehiculo. Simulacion Braking

En la grafica anterior podemos observar como ambas ruedas de un mismo eje tienen el mismo
par de frenado. Ademas, las ruedas delanteras tienen un par de frenado mayor que las
traseras, puesto que poseen unos tamafios de tambor mas grandes.
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Una situacidn cuotidiana de la vida real es la frenada en curva. Mediante este tipo de ensayos,
podemos observar cdmo reacciona el vehiculo cuando esta girando una curva de cierto radio y
se realiza una deceleracion de frenada.

Para realizar el ensayo Braking In Turn debemos iniciarlo desde Simulate -> Full-Vehicle
Analysis -> Cornering Events -> Braking In Turn. En nuestro caso, nuestro modelo girara por
una curva de 30 metros de radio con una aceleracién lateral de 0.1g y con una deceleracién de
frenado de 0.07g, tal y como podemos ver en la siguiente figura.

W Full-Vehicle Analysis: Braking-In-Turn *
Full-Vehicle Assembly | full_c2cv -]
Qutput Prefix | Brakin_In_Turr|

Simulation Mode interactive -

Road Data File ’ |mdids:.ffacar_sharedfroads.tbl.&d_ﬁ

Output Step Size | 04

Gear Position Jm

Lateral Acceleration (G's) |[J_3

Turn Radius |3[]

Length Units ,m—L|

Turn Direction @ left  right

Steering Input | lock steering while braking j

Brake Deceleration (G's) | 0.07

Maximum Brake Duration | 10
¥ Quasi-Static Skidpad Setup
Entry Distance | model units J

Settle Time |
Iv Create Analysis Log File
&

Figura 7-17. Parametros del analisis Braking In Turn

'Lll‘ OK | Apply | Cancel |

Seguidamente, acudimos al PostProcesador para analizar los resultados.

350

i

chassis_velocities.longitudinal l

30.0 1

25.04

Velocity (kmth)

20.0 1

15.0

10.0 T T
0.0 5.0 10.0 15.0
Analysis: Brakin_In_Turn_bit Time (sec)

Figura 7-18. Analisis de la velocidad de vehiculo. Simulacién Braking In Turn
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30

2.9+

2.8+

27

26

transmission gear_number_front

25

No Units

2.4+

234

2.2

2.1

20 T
0.0 5.0 10.0 15.0

Analysis: Brakin_In_Turn_bit Time (sec)

Figura 7-19. Analisis del cambio de marchas del vehiculo. Simulacién Braking In Turn

Como podemos observar, a lo largo del recorrido el vehiculo va decelerando debido a la
condicion de deceleracion de frenada de 0.07g implantada en el analisis. Como podemos
observar, también se reduce la marcha del vehiculo, puesto que el nuemero de revoluciones es
inferior al limite impuesto en la modelizacion del motor tal y como podemos ver en la
siguiente figura.

2500.0

engine.output_rpm_front

2000.0 4

1500.0 1

No Units

1000.0

500.0 T T
0.0 50 10.0 15.0

Analysis: Brakin_In_Turn_bit Time (sec)

Figura 7-20. Analisis de rpm del vehiculo. Simulacién Braking In Turn
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01

i chassis_accelerations.longitudinal

0.05

0.0

-0.05

-0.1

Acceleration {g)

-0.15

-0.25 T .
0.0 50 10.0 15.0
Analysis: Brakin_In_Turn_bit Time (sec)

Figura 7-21. Analisis de la aceleracion longitudinal del vehiculo. Simulacién Braking In Turn

chassis_accelerations.lateral

0.05 1
0.0 I

-0.05

-0.1+

-0.15 4

-0.2 4

-0.25

-0.3

Acceleration (g)

-0.35 T T
00 50 10.0 150
Analysis: Brakin_In_Turn_bit Time (sec)

Figura 7-22. Analisis de la aceleracion lateral dl vehiculo. Simulacion Braking In Turn

En las imagenes anteriores, podemos ver como se han impuesto con éxito las condiciones del
analisis. En primer lugar, observamos como la aceleracién longitudinal se establece en -0.7g,
que es el valor declarado como condicién de disefio. Cerca del segundo 10, podemos observar
unas oscilaciones tanto en la aceleracidn longitudinal como en la lateral. Estas oscilaciones son
debidas al cambio de marcha del vehiculo, por lo que tras establecerla los valores vuelven a su
tendencia. Finalmente, en la grafica de aceleracion lateral, podemos observar como la
aceleracién varia desde 0.3g hasta un valor nulo debido a que, finalmente, el vehiculo debe
frenar.
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Mediante el ensayo /SO Lane Change podemos observar el comportamiento del vehiculo a la
hora de cambiar de carril o esquivar un obstaculo en el terreno. En este ensayo, ademas del
comportamiento del vehiculo, también estaria en juego la reaccién del conductor.

Para realizar el ensayo, supondremos que el vehiculo circula a una velocidad de 30 km/h y
debera cambiar de carril bruscamente para evitar un obstaculo. Las condiciones del ensayo son
las siguientes.

d

FullVehicle Assembly | full_c2cv -
Output Prefix |1SO_Lane_Change

Cutput Step Size |[]_1

Simulation Mode |interactiue j

Road Data File h |mu:liI:Is:.F.Facar_shared.frDads.tblf.?n:l_ﬁ
Initial Velocity 130 [kmhr  ~|
Gear Position 5 |3 j

v Quasi-Static Straight-Line Setup

v Create Analysis Log File

ﬂ Ok | Apply | Cancel

Figura 7-23. Parametros del analisis ISO Lane Change

Seguidamente, en el PostProcessor podemos leer los siguientes resultados.

30.02

[

chassis_velocities longitudinal l

30.01

30.0 5

Welocity (kmih)

28.99 1

29.98 1

2997 T T T T T
0.0 5.0 10.0 15.0 200 250 30.0
Analysis: I1SO_Lane_Change_ilc Time (sec)

Figura 7-24. Analisis de la velocidad longitudinal del vehiculo. Simulacién ISO Lane Change
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Figura 7-25. Analisis del desplazamiento lateral del vehiculo. Simulacién ISO Lane Change
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chassis_accelerations lateral

0.2 1
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0.1

0.05

Acceleration (g)

-0.05 A
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Analysis: I1SO_Lane_Change_ilc Time (sec)

Figura 7-26. Analisis de la aceleracion lateral del vehiculo. Simulacién ISO Lane Change
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Figura 7-27. Analisis del giro de volante del vehiculo. Simulacion ISO Lane Change

Como podemos observar en las diferentes graficas, el vehiculo circula a una velocidad
constante estabilizado. Cerca del segundo 5, se modifica el dngulo del volante, lo que produce
en el vehiculo una reduccidn de velocidad debido al giro y una deceleracidn lateral. También,
podemos observar en la grafica del desplazamiento lateral como el vehiculo giray
posteriormente, cerca del segundo 17 vuelve a su direccidn inicial. Como podemos concluir, al
realizar una maniobra de estas caracteristicas aparecen una gran variedad de reacciones en
nuestro vehiculo, las cuales pueden desestabilizar el automovil.
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8. CONCLUSION DEL PROYECTO

8.1 Analisis del proyecto

A lo largo de este Trabajo de Fin de Grado hemos hablado de la historia de un icono
automovilistico como es el Citroén 2CV, asi como de su evolucién. También, hemos realizado
un modelo del vehiculo para analizar su comportamiento mediante la herramienta informatica
Adams Car, la cual nos permite estudiar el comportamiento del vehiculo mediante diferentes
tipos de analisis. Tras ello, hemos estudiado el comportamiento de nuestro modelo para
verificar su correcto funcionamiento.

Ahora bien, tal y como se ha ido mencionando a lo largo del proyecto, esta simulacion no deja
de ser una aproximacién en la realidad.

En primer lugar, hemos de decir que la informacién técnica del Citroén 2CV en la red no es
abundante, por lo que dificulta en gran medida la implementacién del vehiculo en el programa
de simulacién. Adema3s, gracias a realizar el proyecto hemos conocido el gran abanico de
variantes que hay de este vehiculo. Este hecho, a su vez, dificulta la realizacion del mismo
puesto que al hablar en generalidad del 2CV en la red se hace referencia desde el primer
modelo de 1949 hasta las ultimas versiones de los 80. Asi pues, los datos técnicos del vehiculo
encontrados generalmente no dictan la version del 2CV al que pertenece.

En segundo lugar, la herramienta Adams Car es una potente herramienta de modelizaciény
simulacidn, tal y como hemos podido comprobar en la realizacidn del proyecto. No obstante,
no es una herramienta muy popular, por lo que tratar de solucionar cualquier problema o
aprender su uso es una tarea complicada ya que existen pocos manuales en la red. Ademas, la
herramienta nos puede restringir a la hora de realizar disefios tal y como nos ha ocurrido en el
proyecto, como por ejemplo en el momento de modelizar los brazos de las suspensiones, los
cuales poseen una geometria compleja que Adams no es capaz de crear. Finalmente, podemos
afirmar que Adams es una herramienta compleja de utilizar, ya que realizar la modelizacion
completa de las suspensiones ha sido un procedimiento largo y complejo. Ademads, hemos
tenido que partir de la hipdtesis de que nuestro vehiculo posee frenos de disco dado que no ha
sido posible crear frenos de tambor lo cual ha provocado un error en la obtencién de la
distancia de frenado.

Finalmente, hemos de mencionar el hecho de que se ha tomado la hipdtesis de que el
funcionamiento de los mecanismos es ideal, es decir, no existe friccion entre ellos pese a que
Adams Car nos permite incorporarla.

Por esta serie de acontecimientos podemos concluir que el modelo realizado es una
aproximacion a la realidad, por lo que los resultados obtenidos no se han de tomar como
valores de medicidn reales. De cualquier forma, realizar este proyecto nos ha servido para
conocer la historia de un vehiculo histdrico de nuestro pais, ademas de cémo esta fabricado y
como ha ido evolucionando desde su primera version.

8.2 Opinidn personal

El proyecto de modelizar el Citroén 2CV en Adams Car para su posterior analisis era un trabajo
gue me motivaba, puesto que abarcaba los conocimientos de la ingenieria mecdanica y de los
automoviles, dos de mis ramas de estudio favoritas. No obstante, la limitacién de horas para
realizar el proyecto me ha creado cierto malestar, puesto que considero que se puede trabajar
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mas en el proyecto realizando comparaciones entre los diferentes sistemas de suspensién que
ha tenido el Citroén 2CV. Considero que algunos aspectos del proyecto podrian desarrollarse
con mayor precisién, como pueden ser las medidas de la suspensién o las diferentes hipdtesis
gue hemos tenido que considerar. De cualquier modo, es una buena manera para aprender a
usar el programa Adams Car y conocer aspectos fundamentales sobre los automdviles.
También, este proyecto es un buen método para conocer profundamente un vehiculo, su
comportamiento y su funcionamiento.
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9.PLIEGO DE CONDICIONES

Para realiar el Trabajo de Fin de Grado Modelado y simulacion dindmica del Citroén 2CV es
necesario establecer una serie de condiciones. Por ello, a lo largo de este capitulo trataremos
de exponer las herramientas que vamos a necesitar, asi como sus caracteristicas.

En primer lugar, necesitaremos un laptop Lenovo G50-80 que incorpore un procesador Intel
CORE i5, una tarjeta grafica AMD Radeon, 4GB de memoria RAM y 1 TB de disco duro para
realizar el proyecto.

Tambien sera necesaria la licencia del programa MSC Adams Car version 2017.1 para realizar el
modelaje y andlisis del vehiculo.

Necesitaremos poseer una licencia para el paquete Microsoft Office Professional 2016 para
realizar la redaccion de la memoria y las curvas motor del vehiculo.

Ademas, para el diseio del vehiculo necesitaremos el software SolidWorks 2014, puesto que
las versiones posteriores no son compatibles con nuestro archivo SLDPRT.

Finalmente, utilizaremos el vehiculo Citroén 2CV de D. Francisco José Lerma para realizar
mediciones y andlisis del automovil.
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10. PRESUPUESTO

Horas de los ingenieros

Concepto

Consultas al tutor del proyecto

Ingeniero Mecanico

Licencias informaticas

Concepto

Microsoft Office Professional 2016

SolidWorks 2014 Student Edition

MSC Adams Car

Material de proyecto

Concepto

PC Lenovo G50-80

Material de oficina

Cantidad
en horas Precio

40 15,00 €

380 9,00 €

TOTAL

Cantidad
en horas

60

290

TOTAL

Cantidad
en horas

370

TOTAL

COSTE TOTAL
IVA
COSTE TOTAL DEL PROYECTO

Parcial

600,00 €

3.420,00 €

4.020,00 €

Precio

99,00 €

125,00 €

1.906,00 €

2.130,00 €

Precio

370,00 €

24,00 €

394,00 €

6.544,00 €

1.374,24 €
7.918,24 €

El coste total del proyecto es de siete mil novecientos dieciocho con veinticuatro céntimos
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12. ANEXOS
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12.1 Anexo I. Evolucidon del Citroén 2CV

Year

Engine - Clutch -

Gearbox -
transmission

Suspension -
Brakes -

Steering - Tyres

Electrical
equipment

Bodywork - Colours

Interior
fittings

Weight -
Performance

bhp @ 4 000 rpm

1949|375 cc 4 friction Battery 6 volt - ||[No door locks No ignition Weight 510 kg
6.2 -1 dampers 50 Ah Gunmetal grey body |lkey Maximum speed
compression ratio |4 inertia shock |6 volt dynamo [[Aluminium colour Grey 65 kph
9 bhp @ 3 500 absorbers One rear light (jwheels upholstery Fuel
rpm Michelin Pilote |[|One stop lamp Black steering [[consumption 4 to
125 x 400 wheel 5 litres per 100
km
1953(/4 blade fan No change No change Lockable doors Ignition key [[No change
introduced
Lighter grey
paintwork
Yellow wheels
1955|425 cc No change Indicator lights [|[Restyled badge loses |[Blue tartan Maximum speed
6.2:1 ITwo rear lights |[its oval surround upholstery 70 kph
compression ratio one of which Rubber bung fitted to ||Grey steering ||Fuel
12 bhp @ 3 500 comprises the |lenable front windows |wheel consumption 5
rpm stop lamp to be left in the fully litres/100 km
Centrifugal clutch open position
1956||Compression ratio ||[No change No change No change No change No change
increasedto 7 : 1
1957|Introduction of AZL||No change No change Wheels, steering Demister No change
wheel and seat fitted
frames in light grey
Larger rear screen
1958||Introduction of No change No change Metal boot lid No change No change
AZLP introduced
1958||2 CV 4 x 4 Sahara [|Reinforced 60 Ah battery |[Cutaway rear wings |Floor mounted|Maximum speed
2 x 425 cc suspension 2 dynamos Spare wheel mounted |[gearchange 100 kph
engines, one at arms on bonnet Fuel
front, one at rear consumption 9
litres/100 km
1960||No change 380 diameter No change Blue bodywork Radioén radio [[No change
wheels available available as
135 x 380 option
Michelin Pilote
tyres
1961|Centrifugal clutch [|[No change No change New bonnet No change No change
available as option
Production of 375
cc models ends
1962|[Power output Dampers No change No change No change Maximum speed
increased to 13.5 |lmodified 85 kph
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1962|[Power output Dampers No change No change No change Maximum speed
increased to 13.5 |[|modified 85 kph
bhp @ 4 000 rpm

1963|(Introduction of No change No change Introduction of 2 CV ||Electric Maximum speed

AZAM Mixte fitted with windcreen 95 kph
Power output tailgate and spare wipers
increased to 18 wheel placed under ||New dash
bhp @ 5 000 rpm bonnet board
Electric fuel
gauge
1964(|No change Tubeless 125 x ||No change No change No change No change
380 tyres
1965(|No change No change No change Front doors hinged at |No change No change
the front
1966((Constant velocity |Hydraulic rear ({12 volt 240 W  ||Introduction of six No change No change
ljoints fitted to shock absorbers |electrical light body
driveshafts system
1967|[No change ”No change No change New door handles New No change
|| dashboard
1968||No change No change No change No change Suspended No change
pedals
1970|(2 CV 4 No change 390 W Indicators fitted in No change Weight 560 kg
435 cc alternator front wings Maximum speed
8.5:1 102 kph
compression ratio 5.4 litres/100 km
26 bhp @ 6 750 fuel consumption
rpm
Weight 560 kg
2CV6 Maximum speed
602 cc 110 kph
8.5:1 6.11 litres/100
compression ratio km fuel
33 bhp @ 7 000 consumption
rpm
1971||9 blade fan Inertia dampers |[No change No change Lap and No change
no longer fitted diagonal seat
on front wheels belts fitted
1974||No change No change No change Rectangular No change No change
headlamps fitted
New grille
New bumpers
1975|(2 CV Spécial No change No change 4 light body re- No change No change
introduced introduced
employing
mechanics of the 2
CV 4

79




Escuela Técnica Superior de Ingenieria del Disedo

UNIVERSIDAD POLITECNICA DE VALENCIA

1976 |2 CV Spot No change No change No change No change No change
introduced
1976||2 CV 6 power No change No change No change No change No change
output reduced to
26 bhp @ 5 500
rpm
19782 cv 4 dropped No change No change No change No change No change
from production
1979||2 CV 6 power No change No change 2 CV Spécial acquires ||[No change No change
output increased 6 light body and
to 29 bhp @ 5 750 round headlights
rpm
Twin choke
carburettor
2 CV 4 ceases
|production
1980 INo change No change No change Charleston introduced|[No change No change
1981||No change Front disc No change Charleston acquires ([[No change
brakes fitted chromed headlamps
1985||12 CV Dolly No change No change No change No change No change

introduced
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12.2 Anexo ll. Especificaciones técnicas

Brand name

The name of the company, which has manufactured this vehicle.

Series
The series the vehicle's model belongs to.

Model name

The model name of the vehicle.

Model code

The code provided by the manufacturer, which marks this model.

Model family
A family this model belongs to.

Produced since
The year since the model has been in production.

Type of vehicle
Information about the body type of this vehicle.

Drive system
The type of the drive system used in the vehicle.

Number of seats
The number of seats the vehicle has.

Number of doors
The number of doors the vehicle has.

Length
The distance from the rear-most point to the front-most point of the vehicle.

Width
The width of the vehicle. Devices like door handles, mirrors and lights usually are not
included in the calculation of the width. The width is measured with doors and windows

closed and the wheels in a straight-ahead position.

Height
The distance from the floor to the top-most part of the vehicle.
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Citroén

2CV

2cv Special

1979

sedan/saloon

front wheel drive
(FWD)

3831.00 mm

(millimeters)

150.8268 in

(inches)

12.5689 ft (feet)

1480.00 mm

(millimeters)

58.2677 in (inches)

4.8556 ft (feet)

1600.00 mm

(millimeters)

62.9921 in (inches)

5.2493 ft (feet)
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Wheelbase
The horizontal distance between the centers of the front and rear wheels. The distance
between the front and rear axle.

Front track

The distance between the centers of the wheels on the front axle.

Rear track

The distance between the centers of the wheels on the rear axle.

Ground clearance
The distance from the lowest hanging point under the vehicle to the ground, measured

with standard vehicle equipment, without cargo or passengers.

Weight
The weight of a vehicle with standard equipment and all necessary operating

consumables, without passengers or cargo.

Weight front/rear
The percentage of weight distribution on the front and rear tyres.

Engine manufacturer

The name of the company, which has manufactured the enginge.

Engine code

The code of the engine.

Engine displacement

The total volume of the air/fuel mixture an engine can produce during one complete
cycle. The engine displacement is the sum if the displacement of its cylinders, which
includes the volume of the space between the upper and lower dead point of every

cylinder.

Number of cylinders
The total number of cylinders in the engine. A cylinder is the space, in which a piston
moves between it's upper and lower dead point.
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2399.00 mm

(millimeters)

94.4488 in (inches)

7.8707 ft (feet)

1259.00 mm

(millimeters)

49.5669 in (inches)

4.1306 ft (feet)

1259.00 mm

(millimeters)

49.5669 in (inches)

4.1306 ft (feet)

150.00 mm

(millimeters)

5.9055 in (inches)

0.4921 ft (feet)

561 kg (kilograms)

1236.79 Ib (pounds)

58.00% / 42.00%

Citroén

~0.41 (liters)

435 cc (cubic

centimeters)
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Cylinder arrangement
Information on how the cylinders in the engine are arranged. Some of the most common

arrangements are: Inline, V and Boxer (opposite).

Valves per cylinder
Most engines have two or more valves per cylinder to control the flow of gases and
fluids at proper timings. Intake valves are used to control the flow of air and fuel into

each cylinder, while the exhaust valves make sure exhaust gases leave the cylinder.

Bore
The diameter of the cylinder in the engine. Most internal combustion engines have bores

in the 70 mm - 105 mm range.

Stroke
The length of the piston stroke within the cylinders. The distance the piston travels back-

and-forth between it's upper and lower dead point.

Compression ratio
The ratio between the largest and the smallest volume of the combustion chamber when
the piston is at the top of its stroke (smallest volume) and the bottom of its stroke

(largest volume).

BMEP
Break mean effective pressure is the average pressure that acts on the piston. The
higher the pressure is, the more optimized design has been achieved. BMEP takes into

account engine's volume, rpm and power output.

Aspiration
The type of aspiration. Some engines are naturally aspirated, while others are
turbo/supercharged.

Engine design
The design of the engine in regards to the number and arrangement of camshaft(s),

intake and exhaust valves, etc.

Sump type
The lubricating oil system used to oil the engine's parts. Lubrication prevents friction and

respectively - wearing out of the elements, which are in contact while the engine is

working. There are two main types of sump systems - wet and dry.
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boxer

68.50 mm

(millimeters)

2.6969 in (inches)

0.2247 ft (feet)

59.00 mm

(millimeters)

2.3228in (inches)

0.1936 ft (feet)

8.50:1

117.27 psi (pounds
per square inch)

808.55 kPa
(kilopascals)

8.09 bar (bars)

naturally-aspirated

overhead valve
(OHV)
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Main bearings
The main bearings are the bearings on which the crankshaft rotates. The number of

main bearings depends on the engine type.

Coolant

The type of engine coolant system used to remove the heat from the engine.

Intercooler
An air-to-air or air-to-liquid heat exchange device used between the turbo and the intake

manifold to reduce the temperature of the air, which increases its density.

Engine location
The location of the engine in the vehicle - whether it is front mounted, middle mounted or

rear mounted.

Engine alignment

The alignment/orientation of the engine in the vehicle. A transverse engine is mounted
so that the engine's crankshaft axis is perpendicular to the long axis of the vehicle.
Longitudinal engine is mounted so that the crankshaft is paralel to the long axis of the

vehicle.

Fuel system

The fuel system type used to store and supply fuel in the cylinder chamber.

Catalytic converter
It reduces the toxicity of the emissions from the engine by causing a chemical reaction

that transforms harmful gases into less harmful substances.

Max power

The maximum amount of power the engine can produce.

Max power at rpm

The number of revolutions per minute at which the engine produces its maximum power.

Max torque
The maximum torque the engine can produce. Torque is the turning effect, produced
when force is applied to rotate an object around an axis, fulcrum, or pivot.

Max torque at rpm
The number of revolutions per minute at which the engine produces its maximum

torque.
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air

no

front

carburettor

no

18 kW (kilowatts)

25 ps
(Pferdestarke)

24 hp (horse power)

6750 rpm
(revolutions per

minute)

28 Nm (newton

meters)

20 ft-Ib (foot-
pounds)

2 kgm (kilogram

meters)

3750 rpm
(revolutions per

minute)
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Max speed

The maximum speed the vehicle can achieve.

Max rpm
The maximum number of revolutions per minute of the crankshaft the engine is allowed

to run.

0 - 60 mph

The time in seconds in which the vehicle accelerates from 0 to 60 miles per hour.

0 - 100 km/h

The time in seconds the vehicle needs to accelerate from 0 to 100 kilometers per hour.

Quarter mile time

The time in seconds the vehicle needs to do a quarter mile.

Drag coefficient (C4/C«/Cw)
Quantifies the resistance (drag) of the vehicle, while moving through the air.
Contemporary automobiles achieve a drag coefficient from 0.30 to 0.35. Cq is also

known as Cx in France and Cy in Germany

Frontal area (A)

The total surface area of the front of a vehicle that is exposed to the air flow.

Drag area (C¢A)
Expresses the aerodynamic efficiency of the vehicle and is measured by multiplying the
drag coefficient (Cd) and the frontal surface area (A). The lower the drag area is the

more efficient aerodynamically the vehicle is.

Fuel capacity

The maximum amount of fuel that the vehicle's fuel tank can hold.

Fuel consumption - urban
The amount of fuel used by the vehicle to cover the distance of 100 kilometers where
the speed varies from 0 to 50 km/h.

Fuel consumption - extra urban
The amount of fuel used by the vehicle to cover the distance of 100 kilometers where
the speed varies from 80 to 120 km/h.

Fuel consumption - combined
The average amount of fuel consumed by the vehicle per unit distance in urban and

extra-urban traffic.
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102 km/h
(kilometers per

hour)

63.38 mph (miles

per hour)

24.30 s (seconds)

20.00 1 (liters)

5.28 US gal (US

gallons)

4.40 UK gal (UK

gallons)
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CO; emissions
Information about the carbone dioxide emitted by the vehicle. The average CO:2

emissions rating is 167 grams of carbon dioxide per kilometer driven.

Suspension front
Information about the front suspension mechanism used in the vehicle. The mechanical

system that connects the wheels and axles to the chassis of the vehicle.

Suspension rear
Information about the rear suspension mechanism used in the vehicle. The suspension
contributes to the vehicle's handling and braking, isolates the passengers from the road

noise and vibrations.

Transmission
A transmission a.k.a gearbox adapts the output of the engine to the drive wheels. The
transmission can increase the torque while reducing the speed of the crankshaft or do

the opposite - reduce the torque while increasing the speed of the crankshaft.

Number of gears
The number of gears in the transmision of the vehicle.

Top gear ratio

The gear ratio of the top gear. The gears ratio expresses the ratio between the number
of teeth of the larger gear and the pinion, or simply put the ratio between the gears
radiuses/diameters. E.g. the ratio of a gear with 24 teeth and a pinion with 13 teeth is
1.84:1.

Final drvie ratio
The final drive ratio expresses the ratio between the number of rotations of the drive
shaft for one rotation of a wheel or the ratio between the number of revolutions of the

pinion for one revolution of the drive axle.

Brakes front
The brake system used on the front wheels. In general, the brake system transmits the
force from the brake pedal to the brake pads, which allows the vehicle to slow down and

stop.

Brakes rear

Information about the brake system used on the rear wheels.

Front brake diameter
The diameter of the front brake disks. The brake disk is located between the brake pads,
which when forced against both sides of the disk slow and stop the rotation of the wheel.

Rear brake diameter
The diameter of the rear brake disks.

Wheels front
The sizeltype of the front wheels. For example in "7.5J x 16", the first number represents
the width in inches, the second one represents the height in inches. The letter J

represents the wheel contour.
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Wheels rear

The sizeltype of the rear wheels used in the vehicle.

Tyres front

The sizeltype of the front tyres. For example in the tyre code "225/55 R 16" the first
number stands for width in mm, the second number stands for aspect ratio of height to
width in %, R stands for construction type (radial) and 16 stands for wheel diameter in

inches.

Tyres rear

The sizeltype of the rear tyres used in the vehicle.

Turning circle
The smallest possible diameter of the circle described by the outside wheels when the

vehicle is turning on full lock.

Steering
Information about the design of the mechanism used in the vehicle which allows it to
follow the desired course. The steering mechanism aims to ensure that the wheels are

pointing in the desired directions.

Turns lock to lock
The number of complete rotations a steering wheel makes when turned from one

extreme lock position to the other. For example, from extreme left to extreme right.
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12.3 Anexo lll. Subsistemas

$ MDI_HEADER
[MDI_HEADER]
FILE_ TYPE = 'sub'

FILE_VERSION = 7.0

FILE_FORMAT = 'AsCll'
S SUBSYSTEM_HEADER

[SUBSYSTEM_HEADER]
TEMPLATE_NAME = 'mdids://Citroen2CV/templates.tbl/ suspension_frontal.tpl'

MAJOR_ROLE = 'suspension’

MINOR_ROLE = 'front'

TIMESTAMP = '2017/07/04,17:25:22'

S UNITS
[UNITS]

LENGTH = 'mm’

FORCE = 'newton’

ANGLE = 'deg'

MASS = 'kg'

TIME = 'sec'

S HARDPOINT
[HARDPOINT]

{hardpoint_name symmetry x_value vy _value z value}
'arm_1 ' 'left/right' 680.0 -500.0 250.0
'arm_2 ' 'left/right' 1100.0 -500.0 380.0
‘arm_3 ' 'left/right' 1200.0 -500.0 250.0
'center_upright ' 'left/right' 680.0 -600.0 335.0
'drive_shaft_inr ' 'left/right' 680.0 -200.0 500.0
'lwr_circle_upright " 'left/right' 680.0 -600.0 280.0
'spring_1 ' 'left/right' 1850.0 -500.0 260.0
'spring_2 ' 'left/right' 1640.0 -500.0 257.0
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'tierod_inner ' 'left/right' 1050.0 -50.0 400.0
'tierod_outer ' 'left/right' 800.0 -600.0 400.0
'top_circle_upright ' 'left/right' 680.0 -600.0 390.0
'wheel_center " 'left/right' 680.0 -630.0 335.0
'wheel_to_arm ' 'left/right' 680.0 -600.0 250.0

S PART_ASSEMBLY

[PART_ASSEMBLY]

USAGE = 'arm'
SYMMETRY = 'left/right’
MODE = 'rigid'

S Rigid body data:

MASS = 9.9458045723
SPRUNG_PERCENTAGE = 100.0

S Part location is dependent.

S X,Y,Zlocation = 680.0, -550.0, 250.0
$ Part orientation is dependent.

S ZPvector=0.0, 1.0, 0.0

$ XPvector=1.0, 0.0, 0.0

CM_LOCATION_FROM_PART_X = 265.1900681165

CM_LOCATION_FROM_PART_Y = -93.9960909915

CM_LOCATION_FROM_PART Z = 53.4958357204

IXX = 90190.9864307268
Yy = 3.6985559585E+05
122 = 4.3824572639E+05
IXY = -69414.0395741797
1ZX = 30342.5622144742
IYZ = -10754.8606894821
S LINK_GEOMETRY

[LINK_GEOMETRY]
USAGE = 'arm_1'

PART = 'arm'
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SYMMETRY = 'left/right'
RADIUS = 20.0

S LINK_GEOMETRY

[LINK_GEOMETRY]

USAGE = 'arm_2'
PART = 'arm’
SYMMETRY = 'left/right'

RADIUS = 20.0

S LINK_GEOMETRY
[LINK_GEOMETRY]

USAGE = 'arm_3'

PART = 'arm'

SYMMETRY = 'left/right'

RADIUS = 20.0

S PART_ASSEMBLY

[PART_ASSEMBLY]

USAGE = 'bar_front'
SYMMETRY = 'left/right'
MODE = 'rigid'

S Rigid body data:

MASS = 0.2634533023
SPRUNG_PERCENTAGE = 100.0

S Part location is dependent.

S X,Y,Zlocation = 1525.0, -500.0, 255.0

$ Part orientation is dependent.

$ ZPvector =0.9998816778, 0.0, 0.015382795

S XP vector =0.015382795, 0.0, -0.9998816778
CM_LOCATION_FROM_PART_X = -2.092108612E-14

CM_LOCATION_FROM_PART_Y

-1.4480624693E-16

2.7755575616E-14

CM_LOCATION_FROM_PART_Z

IXX = 4306.8651806095
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Yy = 4306.8651806095

122 = 3.198263218

IXY = 4.5163510668E-14

1ZX = -4,9580289696E-13

Yz = 6.5076131994E-13

S LINK_GEOMETRY

[LINK_GEOMETRY]

USAGE = 'bar_front'
PART = 'bar_front'
SYMMETRY = 'left/right'
RADIUS = 5.0

S PART_ASSEMBLY

[PART_ASSEMBLY]

USAGE = 'spindle’
SYMMETRY = 'left/right'
MODE = 'rigid'

S Rigid body data:

MASS = 0.4759428829
SPRUNG_PERCENTAGE = 100.0

S Part location is dependent.

$ X,Y,Zlocation = 680.0, -630.0, 335.0
$ Part orientation is dependent.

S ZPvector=0.0, -1.0, 0.0

S XPvector=1.0, 0.0, 0.0

CM_LOCATION_FROM_PART_X

4.2531569558E-16

CM_LOCATION_FROM_PART_Y = -1.3658405012E-15

CM_LOCATION_FROM_PART Z = -25.0
IXX = 145.377474755

IYY = 145377474755

12z = 92.4454149704

IXY = 2.6248950276E-15
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1ZX 2.8071531043E-14

Yz 8.6644805359E-15

S PART_ASSEMBLY

[PART_ASSEMBLY]

USAGE = 'spring'
SYMMETRY = 'left/right’
MODE = 'rigid'

S Rigid body data:

MASS = 1.0
SPRUNG_PERCENTAGE = 100.0

S Part location is dependent.

$ X,Y,Zlocation = 1745.0, -500.0, 258.5

PART_ORI_ZP1 = 0.0
PART_ORI_ZP2 = 0.0

PART_ORI_ZP3 = 1.0

PART_ORI_XP1 = 1.0

PART_ORI_XP2 = 0.0

PART_ORI_XP3 = 0.0

CM_LOCATION_FROM_PART_X = 0.0
CM_LOCATION_FROM_PART_Y = 0.0
CM_LOCATION_FROM_PART_Z = 0.0

IXX = 1.0

Yy = 1.0

12z = 1.0

IXY = 0.0

1ZX = 0.0

IYZ = 0.0

S PART_ASSEMBLY

[PART_ASSEMBLY]
USAGE = 'tierod'

SYMMETRY = 'left/right’
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MODE = 'rigid'

S Rigid body data:

MASS = 1.4786818495
SPRUNG_PERCENTAGE = 100.0

S Part location is dependent.

$ X,Y,Zlocation = 925.0, -325.0, 400.0

S Part orientation is dependent.

S ZP vector = 0.4138029443, 0.9103664775, 0.0
S XPvector=0.0, 0.0, -1.0

CM_LOCATION_FROM_PART_X = 6.2039701601E-14

CM_LOCATION_FROM_PART_Y = -1.2220851944E-13

CM_LOCATION_FROM_PART Z = 0.0
IXX = 47612.4902318764

IYY = 47612.4902318764

12z = 71.8034464333

IXY = -2.2795411979E-12

1ZX = 2.4768590094E-12

IYZ = 3.0973420358E-12

$ LINK_GEOMETRY

[LINK_GEOMETRY]

USAGE = 'tierod'
PART = 'tierod'
SYMMETRY = 'left/right'
RADIUS = 10.0

S PART_ASSEMBLY

[PART_ASSEMBLY]

USAGE = 'upright'
SYMMETRY = 'left/right'
MODE = 'rigid'

S Rigid body data:

MASS = 3.5038332864
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SPRUNG_PERCENTAGE = 100.0
S Part location is dependent.

$ X,Y,Zlocation = 680.0, -630.0, 335.0

PART_ORI_ZP1 = 0.0
PART_ORI_ZP2 = 0.0
PART_ORI_ZP3 = 1.0
PART_ORI_XP1 =10
PART_ORI_XP2 = 0.0
PART_ORI_XP3 = 0.0

CM_LOCATION_FROM_PART X = 1.3666417102

CM_LOCATION_FROM_PART_Y = 15.3241741759

CM_LOCATION_FROM_PART _Z

-9.104868955

IXX = 4656.1233976497

Yy = 7033.7083290513

1Zz = 3074.2487931568

IXY = 70.2749676342

1ZX = 340.4862674257

Yz = -77.3770682826

S LINK_GEOMETRY

[LINK_GEOMETRY]

USAGE = 'upright_tierod'
PART = 'upright'
SYMMETRY = 'left/right'
RADIUS =15.0

S NSPRING_ASSEMBLY

[NSPRING_ASSEMBLY]

DEFINITION = '.ACAR.forces.ac_spring'
USAGE = 'spring'
SYMMETRY = 'left/right'

PROPERTY_FILE = 'mdids://Citroen2CV/springs.tbl/mdi_0001.spr'

VALUE_TYPE = 'preload'
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USER_VALUE = 0.0

S DAMPER_ASSEMBLY
[DAMPER_ASSEMBLY]

DEFINITION = '".ACAR.forces.ac_damper'
USAGE = 'damper’
SYMMETRY = 'left/right'

PROPERTY_FILE = 'mdids://Citroen2CV/dampers.tbl/damperitos.dpr'

S PARAMETER
[PARAMETER]

{parameter_name symmetry type  value}
'driveline_active " 'single ' 'integer' O

'kinematic_flag " 'single ' 'integer' O
'hub_compliance_offset ' 'single ' 'real' 0.0
'camber_angle ' 'left/right' 'real' 0.0
'drive_shaft_offset ' 'left/right' 'real' 50.0

'toe_angle ' 'left/right' 'real' 0.0
S MDI_HEADER

[MDI_HEADER]

FILE_TYPE = 'sub'

FILE_VERSION = 7.0

FILE_FORMAT = 'ASCII'

$ SUBSYSTEM_HEADER
[SUBSYSTEM_HEADER]

TEMPLATE_NAME = 'mdids://Citroen2CV/templates.tbl/_suspension_trasera.tpl'
MAJOR_ROLE = 'suspension'

MINOR_ROLE 'rear’

TIMESTAMP

'2017/07/04,17:24:50'
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S UNITS
[UNITS]

LENGTH = 'mm’

FORCE = 'newton’

ANGLE = 'deg'

MASS = 'kg'

TIME = 'sec'

S HARDPOINT
[HARDPOINT]

{hardpoint_name symmetry x_value vy _value 2z value}
arm_1 ' 'left/right' 3080.0 -500.0 335.0
'arm_2 ' 'left/right' 2660.0 -500.0 380.0
'arm_3 ' 'left/right' 2560.0 -500.0 250.0
'‘center_upright ' 'left/right' 3080.0 -600.0 335.0
'drive_shaft_inr ' 'left/right' 3080.0 -200.0 500.0
'lwr_circle_upright " 'left/right' 3080.0 -600.0 280.0
'spring_1 ' 'left/right' 1910.0 -500.0 260.0
'spring_2 ' 'left/right' 2120.0 -500.0 257.0
'tierod_inner " 'left/right' 2960.0 -600.0 400.0
'tierod_outer ' 'left/right' 2960.0 -600.0 400.0
'top_circle_upright ' 'left/right' 3080.0 -600.0 390.0
'wheel_center ' 'left/right' 3080.0 -630.0 335.0
'wheel_to_arm ' 'left/right' 3080.0 -600.0 335.0
S PART_ASSEMBLY
[PART_ASSEMBLY]

USAGE = 'arm’

SYMMETRY = 'left/right'

MODE = 'rigid'

S Rigid body data:
MASS = 9.9458045723

SPRUNG_PERCENTAGE = 100.0
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S Part location is dependent.

$ X,Y,Zlocation = 3080.0, -550.0, 335.0
$ Part orientation is dependent.

S ZPvector=0.0, 1.0, 0.0

S XPvector=1.0, 0.0, 0.0

265.1900681165

CM_LOCATION_FROM_PART_X

CM_LOCATION_FROM_PART_Y = -93.9960909915

CM_LOCATION_FROM_PART_Z = 53.4958357204

IXX = 90190.9864307268
IYY = 3.6985559585E+05
122 = 4.3824572639E+05
IXY = -69414.0395741797
1ZX = 30342.5622144742
1IYZ = -10754.8606894821
S LINK_GEOMETRY

[LINK_GEOMETRY]

USAGE = 'arm_1'
PART = "arm'
SYMMETRY = 'left/right'
RADIUS = 20.0

S LINK_GEOMETRY

[LINK_GEOMETRY]

USAGE = 'arm_2'
PART = 'arm'
SYMMETRY = 'left/right'
RADIUS = 20.0

S LINK_GEOMETRY

[LINK_GEOMETRY]
USAGE = 'arm_3'
PART = 'arm'

SYMMETRY = 'left/right’
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RADIUS = 20.0

S PART_ASSEMBLY

[PART_ASSEMBLY]

USAGE = 'bar_front'
SYMMETRY = 'left/right'
MODE = 'rigid'

S Rigid body data:

MASS = 0.2634533023
SPRUNG_PERCENTAGE = 100.0

S Part location is dependent.

$ X,Y,Zlocation = 2235.0, -500.0, 255.0

S Part orientation is dependent.

$ ZP vector =-0.9998816778, 0.0, 0.015382795

S XP vector =0.015382795, 0.0, 0.9998816778

CM_LOCATION_FROM_PART_X = -2.092108612E-14

CM_LOCATION_FROM_PART_Y = -1.4480624693E-16

2.7755575616E-14

CM_LOCATION_FROM_PART_Z

IXX = 4306.8651806095

Yy = 4306.8651806095

1ZZ = 3.198263218

IXY = 4.5163510668E-14

1ZX = -4.9580289696E-13

Yz = 6.5076131994E-13

S LINK_GEOMETRY

[LINK_GEOMETRY]

USAGE = 'bar_front'
PART = 'bar_front'
SYMMETRY = 'left/right’

RADIUS = 5.0

S PART_ASSEMBLY

[PART_ASSEMBLY]
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USAGE = 'spindle’
SYMMETRY = 'left/right’
MODE = 'rigid'

S Rigid body data:

MASS = 0.4759428829
SPRUNG_PERCENTAGE = 100.0

S Part location is dependent.

$ X,Y,Zlocation = 3080.0, -630.0, 335.0
$ Part orientation is dependent.

S ZPvector=0.0, -1.0, 0.0

S XPvector=1.0, 0.0, 0.0

CM_LOCATION_FROM_PART X = 4.2531569558E-16

-1.3658405012E-15

CM_LOCATION_FROM_PART_Y

CM_LOCATION_FROM_PART_Z = -25.0
IXX = 145.377474755

Yy = 145.377474755

12z = 92.4454149704

IXY = 2.6248950276E-15

1ZX = 2.8071531043E-14

IYZ = 8.6644805359E-15

S PART_ASSEMBLY

[PART_ASSEMBLY]

USAGE = 'spring'
SYMMETRY = 'left/right’
MODE = 'rigid'

S Rigid body data:

MASS = 1.0
SPRUNG_PERCENTAGE = 100.0

S Part location is dependent.
S X,Y,Z location = 2015.0, -500.0, 258.5

PART_ORI_ZP1 = 0.0
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PART_ORI_ZP2 = 0.0
PART_ORI_ZP3 = 1.0
PART_ORI_XP1 = 1.0
PART_ORI_XP2 = 0.0
PART_ORI_XP3 = 0.0
CM_LOCATION_FROM_PART X = 0.0
CM_LOCATION_FROM_PART_Y = 0.0
CM_LOCATION_FROM_PART_Z = 0.0
IXX =1.0

Yy = 1.0

122 = 1.0

IXY = 0.0

1ZX = 0.0

IYZ = 0.0
s PART_ASSEMBLY
[PART_ASSEMBLY]

USAGE = 'upright'
SYMMETRY = 'left/right'
MODE = 'rigid'
S Rigid body data:

MASS = 3.5038332864
SPRUNG_PERCENTAGE = 100.0

S Part location is dependent.

S X,Y,Zlocation = 3080.0, -630.0, 335.0

PART_ORI_ZP1 = 0.0
PART_ORI_ZP2 = 0.0
PART_ORI_ZP3 =10
PART_ORI_XP1 =10
PART_ORI_XP2 = 0.0
PART_ORI_XP3 = 0.0

CM_LOCATION_FROM_PART X = 1.3666417102
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CM_LOCATION_FROM_PART_Y = 15.3241741759

-9.104868955

CM_LOCATION_FROM_PART_Z

IXX = 4656.1233976497

Yy = 7033.7083290513

1zz = 3074.2487931568

IXY = 70.2749676342

1ZX = 340.4862674257

1Yz = -77.3770682826

S LINK_GEOMETRY

[LINK_GEOMETRY]

USAGE = 'upright_tierod'
PART = 'upright'
SYMMETRY = 'left/right'

RADIUS =5.0

S NSPRING_ASSEMBLY

[NSPRING_ASSEMBLY]

DEFINITION = '.ACAR.forces.ac_spring'
USAGE = 'spring'
SYMMETRY = 'left/right'

PROPERTY_FILE = 'mdids://Citroen2CV/springs.tbl/mdi_0001.spr'
VALUE_TYPE = 'preload'
USER_VALUE = 0.0

S DAMPER_ASSEMBLY

[DAMPER_ASSEMBLY]

DEFINITION = 'ACAR.forces.ac_damper’
USAGE = 'damper’
SYMMETRY = 'left/right'

PROPERTY_FILE = 'mdids://acar_shared/dampers.tbl/mdi_0001.dpr'

S PARAMETER
[PARAMETER]
{parameter_name symmetry  type value}
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'driveline_active " 'single ' 'integer' O

'kinematic_flag ' 'single ' ‘integer' O
'hub_compliance_offset ' 'single ' 'real' 0.0
'camber_angle ' 'left/right' 'real' 0.0
'drive_shaft_offset ' 'left/right' 'real' 50.0

'toe_angle ' 'left/right' 'real' 0.0

$ MDI_HEADER
[MDI_HEADER]

FILE_TYPE = 'sub'

FILE_VERSION = 7.0

FILE_FORMAT = 'ASCII'

s SUBSYSTEM_HEADER

[SUBSYSTEM_HEADER]
TEMPLATE_NAME = 'mdids://Citroen2CV/templates.tbl/ body.tpl'

MAJOR_ROLE

'body"

MINOR_ROLE = 'any'

TIMESTAMP = '2017/07/03,17:46:29'

S UNITS

[UNITS]

LENGTH = 'mm’

FORCE = 'newton’

ANGLE = 'deg'

MASS = 'kg'

TIME = 'sec'

S HARDPOINT

[HARDPOINT]
{hardpoint_name symmetry x_value y_value z_value}

'aero_center_of pressure 'single ' 1600.0 0.0 800.0
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'path_reference ' 'single ' 0.0 0.0 0.0
"trim_dummy ' 'single ' 1600.0 0.0 700.0
S PART_ASSEMBLY
[PART_ASSEMBLY]
USAGE = 'chassis’
SYMMETRY = 'single'
MODE = 'rigid'
S Rigid body data:
MASS = 600.0
SPRUNG_PERCENTAGE = 100.0
SPRUNG_LOCATION = "any'
PART_LOC_X = 0.0
PART_LOC_Y = 0.0
PART_LOC_Z = 0.0
PART_ORI_ZP1 = 0.0
PART_ORI_ZP2 = 0.0
PART_ORI_ZP3 = 1.0
PART_ORI_XP1 = 1.0
PART_ORI_XP2 = 0.0
PART_ORI_XP3 = 0.0
CM_LOCATION_FROM_PART_X = 1900.0
CM_LOCATION_FROM_PART_Y = 0.0
CM_LOCATION_FROM_PART_Z = 700.0
IXX = 1.443E+09
Yy = 5.16867E+09
122 = 5.07567E+09
IXY = 0.0
1ZX = 0.0
Yz = 0.0
S PART_ASSEMBLY

[PART_ASSEMBLY]
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USAGE = 'trim_mass'
SYMMETRY = 'single'
MODE = 'rigid'

S Rigid body data:

MASS = 1.0
SPRUNG_PERCENTAGE = 100.0
SPRUNG_LOCATION = "any'

S Part location is dependent.

$ X,Y,Zlocation = 1600.0, 0.0, 700.0

PART_ORI_ZP1 = 0.0

PART_ORI_ZP2 = 0.0

PART_ORI_zZP3 =10

PART_ORI_XP1 =1.0

PART_ORI_XP2 = 0.0

PART_ORI_XP3 = 0.0
CM_LOCATION_FROM_PART_X = 300.0
CM_LOCATION_FROM_PART_Y = 0.0
CM_LOCATION_FROM_PART_Z = 0.0

IXX =1.0

IYY =1.0

122 = 1.0

IXY = 0.0

1ZX = 0.0

IYZ = 0.0

S PARAMETER
[PARAMETER]

{parameter_name symmetry  type  value}
'kinematic_flag ' 'single ' 'integer' O
'aero_drag_active " 'single ' 'integer' 1
'aero_frontal_area "'single ' 'real' 1.80E+06

'air_density 'single ' 'real' 1.22E-09
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'drag_coefficient "'single ' 'real' 0.36

'outline_toggle " 'single ' ‘integer' O

S MDI_HEADER

[MDI_HEADER]
FILE_TYPE = 'sub'

FILE_VERSION = 7.0

FILE_FORMAT = 'ASCIl'
S SUBSYSTEM_HEADER

[SUBSYSTEM_HEADER]

TEMPLATE_NAME = '<acar_concept>/templates.tbl/_engine_transmission.tpl'

MAJOR_ROLE = 'powertrain'

MINOR_ROLE = 'front'

TIMESTAMP = '2017/07/04,23:35:58'

S UNITS
[UNITS]

LENGTH = 'mm’

FORCE = 'newton'

ANGLE = 'deg'

MASS = 'kg'

TIME = 'sec'

S HARDPOINT

[HARDPOINT]

{hardpoint_name symmetry x_value y_value z_value}

'engine_transmission_cg 'single ' 650.0 100.0 550.0

'transmission_output 'single ' 750.0 0.0 300.0

'front_engine_mount ' 'left/right' 400.0 -300.0 400.0
'rear_engine_mount ' 'left/right' 850.0 -300.0 400.0
S PART_ASSEMBLY
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[PART_ASSEMBLY]

USAGE = 'powertrain'
SYMMETRY = 'single'
MODE = 'rigid'

S Rigid body data:

MASS = 187.4349375204
SPRUNG_PERCENTAGE = 100.0

S Part location is dependent.

$ X,Y,Zlocation = 650.0, 100.0, 550.0

PART_ORI_ZP1 = 0.0
PART_ORI_ZP2 = 0.0
PART_ORI_zZP3 =10
PART_ORI_XP1 =1.0
PART_ORI_XP2 = 0.0
PART_ORI_XP3 = 0.0
CM_LOCATION_FROM_PART_X = 0.0
CM_LOCATION_FROM_PART_Y = 0.0
CM_LOCATION_FROM_PART_Z = 0.0
IXX = 4.1712889223E+06
Yy = 1.2668213886E+07
122 = 1.0977091463E+07
IXY = 0.0

1ZX = 0.0

IYZ = 0.0

S SWITCH_PART
[SWITCH_PART]

USAGE = 'engine_mount_option'

SYMMETRY = 'single'
$ Switched Parts:
S [1] = nd (unknown part)

S [2] =chassis (general part)
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INDEX =2

S BUSHING_ASSEMBLY

[BUSHING_ASSEMBLY]

DEFINITION = "ACAR.attachments.ac_bushing'
USAGE = 'front_engine_mount'
SYMMETRY = 'left/right’
ORIENTATION_ZP1 = 0.0
ORIENTATION_ZP2 = 0.0
ORIENTATION_ZP3 = 1.0
ORIENTATION_XP1 = 1.0
ORIENTATION_XP2 = 0.0
ORIENTATION_XP3 = 0.0
T_PRELOAD_X = 0.0
T_PRELOAD_Y = 0.0
T_PRELOAD_Z = 0.0
R_PRELOAD_X = 0.0
R_PRELOAD_Y = 0.0
R_PRELOAD_Z = 0.0
T_OFFSET_X = 0.0
T_OFFSET_Y = 0.0
T_OFFSET Z = 0.0
R_OFFSET_X = 0.0
R_OFFSET_Y = 0.0
R_OFFSET Z = 0.0
FX_SCALING_FACTOR = 1.0
FY_SCALING_FACTOR = 1.0
FZ_SCALING_FACTOR = 1.0
TX_SCALING_FACTOR = 1.0
TY_SCALING_FACTOR = 1.0
TZ_SCALING_FACTOR = 1.0

TX_DAMPING_FORCE_SCALE = 1.0
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TY_DAMPING_FORCE_SCALE = 1.0
TZ_DAMPING_FORCE_SCALE = 1.0
RX_DAMPING_FORCE_SCALE = 1.0
RY_DAMPING_FORCE_SCALE = 1.0
RZ_DAMPING_FORCE_SCALE = 1.0
PROPERTY_FILE = '<acar_shared>/bushings.tbl/mdi_0001.bus'
s BUSHING_ASSEMBLY
[BUSHING_ASSEMBLY]

DEFINITION = ""ACAR.attachments.ac_bushing'
USAGE = 'rear_engine_mount'
SYMMETRY = 'left/right’
ORIENTATION_ZP1 = 0.0
ORIENTATION_ZP2 = 0.0
ORIENTATION_ZP3 =1.0
ORIENTATION_XP1 = 1.0
ORIENTATION_XP2 = 0.0
ORIENTATION_XP3 = 0.0
T_PRELOAD_X = 0.0
T_PRELOAD_Y = 0.0
T_PRELOAD Z = 0.0
R_PRELOAD_X = 0.0
R_PRELOAD_Y = 0.0
R_PRELOAD Z = 0.0
T_OFFSET_X = 0.0
T_OFFSET_Y = 0.0
T_OFFSET_Z = 0.0
R_OFFSET X = 0.0
R_OFFSET_Y = 0.0
R_OFFSET_Z = 0.0
FX_SCALING_FACTOR = 1.0
FY_SCALING_FACTOR = 1.0
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FZ_SCALING_FACTOR = 1.0

TX_SCALING_FACTOR =1.0

TY_SCALING_FACTOR =1.0

TZ_SCALING_FACTOR =1.0

TX_DAMPING_FORCE_SCALE = 1.0

TY_DAMPING_FORCE_SCALE = 1.0

TZ_DAMPING_FORCE_SCALE = 1.0

RX_DAMPING_FORCE_SCALE = 1.0

RY_DAMPING_FORCE_SCALE = 1.0

RZ_DAMPING_FORCE_SCALE = 1.0

PROPERTY_FILE = '<acar_shared>/bushings.tbl/mdi_0001.bus'
S GENERAL_SPLINE

[GENERAL_SPLINE]

USAGE = 'capacity_factor'
SYMMETRY = 'single’
TYPE = 'two_dimensional'

PROPERTY_FILE = '<acar_shared>/torque_converters.tbl/mdi_0001.tcf'

CURVE_NAME = 'CAPACITY_FACTOR'

S GENERAL_SPLINE

[GENERAL_SPLINE]

USAGE = 'engine_torque'
SYMMETRY = 'single’'
TYPE = 'three_dimensional'

PROPERTY_FILE = 'mdids://Citroen2CV/powertrains.tbl/curvas.pwr'

CURVE_NAME = 'ENGINE'

S GENERAL_SPLINE

[GENERAL_SPLINE]

USAGE = 'torque_ratio'
SYMMETRY = 'single’
TYPE = 'two_dimensional'

PROPERTY_FILE = '<acar_shared>/torque_converters.tbl/mdi_0001.tcf'
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CURVE_NAME = 'TORQUE_RATIO'

S PARAMETER
[PARAMETER]

{parameter_name symmetry  type  value}
'kinematic_flag " 'single ' ‘integer' O
'powertrain_type " 'single ' 'integer' 1
'clutch_capacity " 'single ' 'real' 1.00E+06
'clutch_close " 'single ' 'real' 0.25
‘clutch_damping " 'single ' 'real' 10000.0
‘clutch_open ' 'single ' 'real' 0.75
'clutch_stiffness "'single ' 'real' 1.00E+06
'clutch_tau "'single ' 'real' 0.05
'ems_gain ' 'single ' 'real' 0.005
'ems_max_throttle " 'single ' 'real' 15.0
'engine_idle_speed " 'single ' 'real' 1000.0
'‘engine_inertia ' 'single ' 'real' 10000.0
‘engine_rev_limit " 'single ' 'real' 6750.0
'engine_stall_speed "'single ' 'real' 750.0
'gear_downshift_2 " 'single ' 'real' 1000.0
'gear_downshift_3 ' 'single ' 'real' 1200.0
'gear_downshift_4 " 'single ' 'real' 1200.0
'gear_downshift_5 " 'single ' 'real' 1300.0
'gear_downshift_6 ' 'single ' 'real' 1400.0
'gear_ratio_1 " 'single ' 'real' 7.0
'gear_ratio_2 " 'single ' 'real' 5.0
'gear_ratio_3 " 'single ' 'real' 3.0
'gear_ratio_4 " 'single ' 'real' 1.47
'gear_ratio_5 " 'single ' 'real' 0.8
'gear_ratio_6 ' 'single ' 'real' 0.65
'gear_ratio R ' 'single ' 'real' -7.0
'gear_sport_1 " 'single ' 'real' 5800.0
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'gear_sport_2 " 'single ' 'real' 5800.0
'gear_sport_3 " 'single ' 'real' 5750.0
'gear_sport_4 " 'single ' 'real' 5750.0
'gear_sport_5 " 'single ' 'real' 5700.0
'gear_upshift_1 " 'single ' 'real' 5000.0
'gear_upshift_2 "'single ' 'real' 4900.0
'gear_upshift_3 ' 'single ' 'real' 4800.0
'gear_upshift_4 ' 'single ' 'real' 4800.0
'gear_upshift_5 "'single ' 'real' 4500.0
'gear_upshift_thlds " 'single ' 'real' 60.0,90.0
'graphics_flag "'single ' ‘integer' 1
'longitudinal " 'single ' 'integer' 0
'max_engine_power "'single ' 'real' 3.10E+08
'max_engine_torque ' 'single ' 'real' 4.00E+05
'max_gears "'single ' ‘integer' 4
'max_throttle 'single ' 'real' 100.0
'min_engine_torque " 'single ' 'real' -40000.0
'oil_dump_residual "'single ' 'real' 0.1
'oil_dump_threshold " 'single ' 'real' 0.1
'oil_dump_throttle_off ' 'single ' 'real' 1.0
'shift_cycle_time "'single ' 'real' 0.5
'sport_flag ' 'single ' 'integer' O
'torque_tau " 'single ' 'real' 0.1

S MDI_HEADER

[MDI_HEADER]

'sub'

FILE_TYPE

FILE_VERSION = 7.0
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FILE_FORMAT = 'ASCII'
S SUBSYSTEM_HEADER

[SUBSYSTEM_HEADER]

TEMPLATE_NAME = 'mdids://Citroen2CV/templates.tbl/_direccion.tpl'

MAJOR_ROLE = 'steering'

MINOR_ROLE = 'front'

TIMESTAMP = '2017/07/04,17:25:26'

s UNITS
[UNITS]

LENGTH = 'mm’

FORCE = 'newton'

ANGLE = 'deg'

MASS = 'kg'

TIME = 'sec'

S HARDPOINT

[HARDPOINT]
{hardpoint_name symmetry x_value vy _value 2z value}
'intermediate_shaft_forward ' 'single ' 1250.0 -300.0 600.0

'intermediate_shaft_rearward ' 'single ' 1400.0 -300.0 1000.0

'pinion_pivot 'single ' 1050.0 -300.0 400.0

'steering_wheel_center ' 'single ' 1650.0 -300.0 1050.0

'rack_house_mount ' 'left/right' 1050.0 -400.0 400.0
'tierod_inner ' 'left/right' 1050.0 -50.0 400.0
S PART_ASSEMBLY

[PART_ASSEMBLY]

USAGE = 'intermediate_shaft'
SYMMETRY = 'single'

MODE = 'rigid'

S Rigid body data:

MASS = 1.0
SPRUNG_PERCENTAGE = 100.0
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S Part location is dependent.

$ X,Y,Zlocation = 1325.0, -300.0, 800.0

$ Part orientation is dependent.

$ ZPvector =0.3511234416, 0.0, 0.9363291776

S XPvector =0.9363291776, 0.0, -0.3511234416

CM_LOCATION_FROM_PART_X = 0.0
CM_LOCATION_FROM_PART_Y = 0.0
CM_LOCATION_FROM_PART_Z = 0.0

IXX = 2764.9179238818

Yy = 2764.9179238818

V4 = 113.1691810841

IXY = 0.0

1ZX = 0.0

IYZ = 0.0

$ LINK_GEOMETRY

[LINK_GEOMETRY]

USAGE = 'intermediate_shaft'
PART = 'intermediate_shaft'
SYMMETRY = 'single'

RADIUS = 15.0445459276

S PART_ASSEMBLY

[PART_ASSEMBLY]

USAGE = 'pinion’
SYMMETRY = 'single'
MODE = 'rigid'

S Rigid body data:

MASS = 0.5
SPRUNG_PERCENTAGE = 100.0

S Part location is dependent.
S X,Y,Z location = 1050.0, -300.0, 400.0

S Part orientation is dependent.
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$ ZPvector =0.7071067812, 0.0, 0.7071067812

$ XP vector =0.7071067812, 0.0, -0.7071067812

CM_LOCATION_FROM_PART_X = 0.0
CM_LOCATION_FROM_PART_Y = 0.0
CM_LOCATION_FROM_PART_Z = 0.0
IXX =1.0

Yy = 1.0

122 = 1.0

IXY = 0.0

1ZX = 0.0

IYZ = 0.0

s PART_ASSEMBLY
[PART_ASSEMBLY]

USAGE = 'rack'
SYMMETRY = 'single’'

MODE = 'rigid'

S Rigid body data:

MASS = 1.8888888889
SPRUNG_PERCENTAGE = 100.0

S Part location is dependent.

$ X,Y,Zlocation = 1050.0, 0.0, 400.0
$ Part orientation is dependent.

S ZPvector=0.0, -1.0, 0.0

S XPvector=1.0, 0.0, 0.0

CM_LOCATION_FROM_PART X = 0.0

CM_LOCATION_FROM_PART_Y = 0.0

CM_LOCATION_FROM_PART Z = 0.0

IXX = 1.1376967058E+05
IYY = 1.1376967058E+05
1zZ = 85.6374549196
IXY = 0.0
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1ZX = 0.0
Yz = 0.0
S

[LINK_GEOMETRY]
USAGE = 'rack’
PART = 'rack’

SYMMETRY = 'single'

RADIUS = 9.5223396425

$

[PART_ASSEMBLY]

USAGE = 'rack_housing'
SYMMETRY = 'single’'
MODE = 'rigid'

S Rigid body data:

MASS = 4.0
SPRUNG_PERCENTAGE = 100.0

S Part location is dependent.

$ X,Y,Zlocation = 1050.0, 0.0, 400.0
$ Part orientation is dependent.

S ZPvector=0.0, -1.0, 0.0

$ XPvector=1.0, 0.0, 0.0

CM_LOCATION_FROM_PART X = 0.0
CM_LOCATION_FROM_PART_Y = 0.0
CM_LOCATION_FROM_PART_Z = 0.0
IXX = 2.1353735198E+05
IYY = 2.1353735198E+05
12z = 408.0372851994
IXY = 0.0

1ZX = 0.0

\74 = 0.0

S

LINK_GEOMETRY

PART_ASSEMBLY

LINK_GEOMETRY
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[LINK_GEOMETRY]

USAGE = 'rack_housing'
PART = 'rack_housing'
SYMMETRY = 'single'
RADIUS = 14.2835094637

S PART_ASSEMBLY

[PART_ASSEMBLY]

USAGE = 'steering_column'
SYMMETRY = 'single'

MODE = 'rigid'

S Rigid body data:

MASS = 2.0
SPRUNG_PERCENTAGE = 100.0

S Part location is dependent.

$ X,Y,Zlocation = 1525.0, -300.0, 1025.0

$ Part orientation is dependent.

$ ZP vector =-0.9805806757, 0.0, -0.1961161351

S XPvector =-0.1961161351, 0.0, 0.9805806757

CM_LOCATION_FROM_PART X = 0.0
CM_LOCATION_FROM_PART_Y = 0.0
CM_LOCATION_FROM_PART Z = 0.0

IXX = 22195.429797

IYY = 22195.429797

12z = 224.1929264276

IXY = 0.0

1ZX = 0.0

\74 = 0.0

$ LINK_GEOMETRY

[LINK_GEOMETRY]
USAGE = 'steering_column'

PART = 'steering_column'
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SYMMETRY = 'single’
RADIUS = 14.9730733795

S PART_ASSEMBLY

[PART_ASSEMBLY]

USAGE = 'steering_shaft'
SYMMETRY = 'single'
MODE = 'rigid'

S Rigid body data:

MASS = 1.5689290811
SPRUNG_PERCENTAGE = 100.0

S Part location is dependent.

$ X,Y,Zlocation = 1150.0, -300.0, 500.0

$ Part orientation is dependent.

$ ZP vector =0.7071067812, 0.0, 0.7071067812

S XP vector =0.7071067812, 0.0, -0.7071067812

CM_LOCATION_FROM_PART_X = 0.0
CM_LOCATION_FROM_PART_Y = 0.0
CM_LOCATION_FROM_PART_Z = 0.0

IXX = 10548.304417

Yy = 10548.304417

122 = 177.5544192877

IXY = 0.0

1ZX = 0.0

\74 = 0.0

$ LINK_GEOMETRY

[LINK_GEOMETRY]

USAGE = 'steering_shaft'
PART = 'steering_shaft'
SYMMETRY = 'single'
RADIUS = 15.0445459276

S PART_ASSEMBLY
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[PART_ASSEMBLY]

USAGE = 'steering_wheel'
SYMMETRY = 'single'
MODE = 'rigid'

S Rigid body data:

MASS = 2.1500262923
SPRUNG_PERCENTAGE = 100.0

S Part location is dependent.

$ X,Y,Zlocation = 1650.0, -300.0, 1050.0

$ Part orientation is dependent.

S ZP vector =-0.9805806757, 0.0, -0.1961161351
S XPvector =-0.1961161351, 0.0, 0.9805806757
CM_LOCATION_FROM_PART_X = 0.0

CM_LOCATION_FROM_PART_Y

0.0

CM_LOCATION_FROM_PART_Z = 0.5768768867

IXX = 25892.147854

Yy = 25892.147854

12z = 51629.176982

IXY = 0.0

1ZX = 0.0

IYZ = 0.0

S SWITCH_PART
[SWITCH_PART]

USAGE = 'rack_house_mount'

SYMMETRY = 'single'

S Switched Parts:

S [1] = nd (unknown part)
$ [2] =nd (unknown part)

INDEX =1

S BUSHING_ASSEMBLY

[BUSHING_ASSEMBLY]
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DEFINITION = ".ACAR.attachments.ac_bushing'
USAGE = 'torsion_bar"

SYMMETRY = 'single’

S Bushing orientation is dependent.

$ ZP vector =0.7071067812, 0.0, 0.7071067812
S XP vector =0.7071067812, 0.0, -0.7071067812
T_PRELOAD_X = 0.0

0.0

T_PRELOAD_Y

T_PRELOAD_Z 0.0

0.0

R_PRELOAD_X

R_PRELOAD_Y

0.0

R_PRELOAD_Z 0.0

T_OFFSET_X 0.0

T_OFFSET_Y = 0.0

T_OFFSET_Z

0.0

R_OFFSET_X 0.0
R_OFFSET_Y = 0.0
R_OFFSET Z = 0.0

FX_SCALING_FACTOR

1.0

FY_SCALING_FACTOR 1.0

FZ_SCALING_FACTOR 1.0
TX_SCALING_FACTOR = 1.0

1.0

TY_SCALING_FACTOR

TZ_SCALING_FACTOR 1.0

TX_DAMPING_FORCE_SCALE = 1.0

TY_DAMPING_FORCE_SCALE = 1.0

TZ_DAMPING_FORCE_SCALE = 1.0

RX_DAMPING_FORCE_SCALE

1.0

RY_DAMPING_FORCE_SCALE = 1.0

RZ_DAMPING_FORCE_SCALE = 1.0

PROPERTY_FILE = 'mdids://acar_shared/bushings.tbl/mdi_steering_tbar.bus'
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S BUSHING_ASSEMBLY

[BUSHING_ASSEMBLY]

DEFINITION = ""ACAR.attachments.ac_bushing'
USAGE = 'rack_housing_bushing'
SYMMETRY = 'left/right'

$ Bushing orientation is dependent.
S ZPvector=0.0, 1.0, 0.0
S XPvector=1.0, 0.0, 0.0
T_PRELOAD_X = 0.0

0.0

T_PRELOAD_Y

T_PRELOAD_Z

0.0

R_PRELOAD_X 0.0

R_PRELOAD_Y 0.0

R_PRELOAD_Z 0.0

T_OFFSET_X

0.0

T_OFFSET_Y 0.0

T_OFFSET_Z 0.0

R_OFFSET_X 0.0

R_OFFSET_Y

0.0

R_OFFSET_Z = 0.0

FX_SCALING_FACTOR 1.0

FY_SCALING_FACTOR

1.0

1.0

FZ_SCALING_FACTOR

TX_SCALING_FACTOR 1.0

TY_SCALING_FACTOR 1.0

TZ_SCALING_FACTOR = 1.0

TX_DAMPING_FORCE_SCALE = 1.0

TY_DAMPING_FORCE_SCALE

1.0

TZ_DAMPING_FORCE_SCALE = 1.0

RX_DAMPING_FORCE_SCALE = 1.0

RY_DAMPING_FORCE_SCALE = 1.0
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RZ_DAMPING_FORCE_SCALE = 1.0
PROPERTY_FILE = 'mdids://acar_shared/bushings.tbl/mdi_0001.bus'

S GEAR_ASSEMBLY

[GEAR_ASSEMBLY]

USAGE = 'input_shaft_pinion_lock'
SYMMETRY = 'single’
REDUCTION_RATIO = 1.0
INVERT_INPUT = 'yes'

S GEAR_ASSEMBLY

[GEAR_ASSEMBLY]

USAGE = 'pinion_to_rack'
SYMMETRY = 'single’
REDUCTION_RATIO = 0.1745329252
INVERT_INPUT = 'yes'

S GEAR_ASSEMBLY

[GEAR_ASSEMBLY]

USAGE = 'steering_wheel_column_lock'
SYMMETRY = 'single’

REDUCTION_RATIO = 1.0

INVERT_INPUT = 'no'

S GENERAL_SPLINE

[GENERAL_SPLINE]

USAGE = 'steering_assist'
SYMMETRY = 'single’
TYPE = 'two_dimensional'

PROPERTY_FILE = 'mdids://acar_shared/steering_assists.tbl/mdi_steer_assist.ste'
CURVE_NAME = 'steering_assist'

S GENERAL_PARAMETER

[GENERAL_PARAMETER]
USAGE = 'rack_piston_area'

SYMMETRY = 'single’'
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PROPERTY_FILE

DATA_BLOCK = 'STEERING_ASSIST'

ATTRIBUTE_NAME = 'piston_area'

'mdids://acar_shared/steering_assists.tbl/mdi_steer_assist.ste'

S PARAMETER
[PARAMETER]

{parameter_name symmetry type  value}
'kinematic_flag ' 'single ' 'integer' O
'steering_assist_active ' 'single ' 'integer' 1
'max_rack_displacement ' 'single ' ‘'real' 100.0
'max_rack_force " 'single ' 'real' 500.0
'max_steering_angle "'single ' 'real' 720.0
'max_steering_torque "'single ' 'real' 500.0

S MDI_HEADER
[MDI_HEADER]

FILE_TYPE = 'sub'

FILE_VERSION = 7.0

FILE_FORMAT = 'ASCII'

S SUBSYSTEM_HEADER

[SUBSYSTEM_HEADER]

TEMPLATE_NAME = '<acar_concept>/templates.tbl/_driveline_fwd_LSD.tpl'

UNITS

MAJOR_ROLE = 'driveline'
MINOR_ROLE = 'front'

TIMESTAMP = '2017/07/04,17:25:31'
S

[UNITS]

LENGTH = 'mm’

FORCE = 'newton’

ANGLE = 'deg'
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MASS = 'kg'
TIME = 'sec'
S HARDPOINT

[HARDPOINT]

{hardpoint_name symmetry x_value vy _value 2z value}
'diff_mount ' 'single ' 680.0 -200.0 350.0
'inner_CVJ ' 'left/right" 680.0 -400.0 350.0

S PART_ASSEMBLY

[PART_ASSEMBLY]

USAGE = 'diff_housing'
SYMMETRY = 'single’'
MODE = 'rigid'

S Rigid body data:

MASS =1.0
SPRUNG_PERCENTAGE = 100.0

S Part location is dependent.

$ X,Y,Zlocation = 680.0, -200.0, 350.0
$ Part orientation is dependent.

$ ZPvector=1.0, 0.0, 0.0

S XPvector=0.0, 1.0, 0.0

CM_LOCATION_FROM_PART X = 0.0
CM_LOCATION_FROM_PART_Y = 0.0
CM_LOCATION_FROM_PART_Z = 0.0

IXX = 1.0

IYY = 1.0

12z = 1.0

IXY = 0.0

1ZX = 0.0

74 = 0.0

$ PART_ASSEMBLY

[PART_ASSEMBLY]
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USAGE = 'diff_input'
SYMMETRY = 'single'
MODE = 'rigid'

S Rigid body data:

MASS = 0.6955492391
SPRUNG_PERCENTAGE = 100.0

S Part location is dependent.

$ X,Y,Zlocation = 680.0, -200.0, 350.0
$ Part orientation is dependent.

S ZPvector=1.0, 0.0, 0.0

S XPvector=0.0, 1.0, 0.0

CM_LOCATION_FROM_PART_X = 0.0
CM_LOCATION_FROM_PART_Y = 0.0
CM_LOCATION_FROM_PART_Z = 7.5

IXX = 347.6321760416

Yy = 347.6321760416

12z = 669.1812556173

IXY = 0.0

1ZX = 0.0

IYZ = 0.0

S PART_ASSEMBLY

[PART_ASSEMBLY]

USAGE = 'diff_output'
SYMMETRY = 'left/right’
MODE = 'rigid'

S Rigid body data:

MASS = 0.6955492391
SPRUNG_PERCENTAGE = 100.0

S Part location is dependent.
S X,Y,Z location = 680.0, -400.0, 350.0

S Part orientation is dependent.
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S ZPvector=0.0, -1.0, 0.0

S XPvector=1.0, 0.0, 0.0

CM_LOCATION_FROM_PART_X = 0.0
CM_LOCATION_FROM_PART_Y = 0.0
CM_LOCATION_FROM_PART Z = -7.5

IXX = 347.6321760416

IYY = 347.6321760416

1zz = 669.1812556173

IXY = 0.0

1ZX = 0.0

\74 = 0.0

$ LINK_GEOMETRY

[LINK_GEOMETRY]

USAGE = 'jack_shaft'
PART = 'diff_output'
SYMMETRY = 'left/right’
RADIUS = 10.0

S PART_ASSEMBLY

[PART_ASSEMBLY]

USAGE = 'halfshaft'
SYMMETRY = 'left/right'
MODE = 'rigid'

S Rigid body data:

MASS = 0.5949286036
SPRUNG_PERCENTAGE = 100.0

S Part location is dependent.

S X,Y,Zlocation = 680.0, -490.0, 342.5

$ Part orientation is dependent.

$ ZPvector = 0.0, -0.9965457582, -0.0830454799
S XP vector=-1.0, 0.0, 0.0

CM_LOCATION_FROM_PART X = 2.236899862E-17
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CM_LOCATION_FROM_PART_Y = -4.1852832761E-16

CM_LOCATION_FROM_PART_Z = 0.0
IXX = 3113.0310732711

Yy = 3113.0310732711

12z = 28.8891921783

IXY = 2.5357172811E-13

1ZX = 7.8441879759E-14

IYZ = 9.1234708951E-14

$ LINK_GEOMETRY

[LINK_GEOMETRY]

USAGE = 'halfshaft’
PART = 'halfshaft’
SYMMETRY = 'left/right'

RADIUS = 10.0

S PART_ASSEMBLY

[PART_ASSEMBLY]

USAGE = 'tripod'
SYMMETRY = 'left/right'
MODE = 'rigid'

S Rigid body data:

MASS = 1.0
SPRUNG_PERCENTAGE = 100.0

S Part location is dependent.

S X,Y,Z location = 680.0, -400.0, 350.0
$ Part orientation is dependent.

S ZPvector=0.0, -1.0, 0.0

S XPvector=1.0, 0.0, 0.0

CM_LOCATION_FROM_PART_X = 0.0
CM_LOCATION_FROM_PART_Y = 0.0
CM_LOCATION_FROM_PART_Z = 0.0

IXX = 1.0
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Yy = 1.0

12z = 1.0

IXY = 0.0

1ZX = 0.0

IYZ = 0.0

S SWITCH_PART
[SWITCH_PART]

USAGE = 'diff_mount'

SYMMETRY = 'single'

$ Switched Parts:

S [1] = nd (unknown part)
S [2] = nd (unknown part)
S [3] =nd (unknown part)
INDEX =1

S GEAR_ASSEMBLY

[GEAR_ASSEMBLY]

USAGE = 'differential’
SYMMETRY = 'single’
REDUCTION_RATIO = 3.0

INVERT_INPUT = 'no'

S GENERAL_SPLINE

[GENERAL_SPLINE]

USAGE = 'front_differential'
SYMMETRY = 'single’
TYPE = 'two_dimensional'

PROPERTY_FILE = '<acar_concept>/differentials.tbl/open_no_torque.dif'

CURVE_NAME = 'DIFFERENTIAL'

s PARAMETER
[PARAMETER]

{parameter_name symmetry  type  value}
'driveline_active ' 'single ' 'string' 'front'
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'kinematic_flag " 'single ' 'integer' O

'jack_shaft_active "'left ' 'integer' O

'jack_shaft_active "'right ' 'integer' 1

'jack_shaft_length "'left ' 'real' 0.0

'jack_shaft_length "'right ' 'real' 400.0

S MDI_HEADER
[MDI_HEADER]

FILE_TYPE = 'sub'

FILE_VERSION = 7.0

FILE_FORMAT = 'ASCII'

S SUBSYSTEM_HEADER

[SUBSYSTEM_HEADER]

TEMPLATE_NAME = 'mdids://Citroen2CV/templates.tbl/ _front_wheels_c2cv.tpl'

MAJOR_ROLE = 'wheel'

MINOR_ROLE = 'front'

TIMESTAMP = '2017/07/04,17:25:12'

S UNITS
[UNITS]

LENGTH = 'mm'

FORCE = 'newton’

ANGLE = 'deg'

MASS = 'kg'

TIME = 'sec'

S WHEEL_ASSEMBLY

[WHEEL_ASSEMBLY]

USAGE = 'wheel'
SYMMETRY = 'left/right'
MASS = 20.0
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SPRUNG_PERCENTAGE = 0.0

IXX = 50000.0
Yy = 50000.0
1zz = 10000.0
CM_OFFSET = 0.0

WHEEL_CENTER_OFFSET = 0.0

HIGH_PERFORMANCE = 'no'

DEFINITION = "ACAR.forces.ac_tire'

PROPERTY_FILE = 'mdids://Citroen2CV/tires.tbl/front_wheels_c2cv_pac89.tir'
CONTACT _TYPE = 'handling'

S PARAMETER
[PARAMETER]

{parameter_name symmetry  type  value}
'kinematic_flag ' 'single ' 'integer' O
'graphics_angle_offset ' 'left/right' 'real' 0.0

S MDI_HEADER
[MDI_HEADER]

FILE_TYPE = 'sub'

FILE_VERSION = 7.0

FILE_FORMAT = 'ASCII'

S SUBSYSTEM_HEADER

[SUBSYSTEM_HEADER]
TEMPLATE_NAME = 'mdids://Citroen2CV/templates.tbl/_rear_wheels_c2cv.tpl'

MAJOR_ROLE 'wheel'

MINOR_ROLE = 'rear’

TIMESTAMP = '2017/07/04,17:25:09'

S UNITS

[UNITS]
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LENGTH = 'mm’

FORCE = 'newton’

ANGLE = 'deg'

MASS = 'kg'

TIME = 'sec'

S WHEEL_ASSEMBLY

[WHEEL_ASSEMBLY]

USAGE = 'wheel'
SYMMETRY = 'left/right'
MASS = 20.0

SPRUNG_PERCENTAGE = 0.0

IXX = 50000.0
Yy = 50000.0
1Zz = 10000.0
CM_OFFSET = 0.0

WHEEL_CENTER_OFFSET = 0.0

HIGH_PERFORMANCE = 'no'

DEFINITION = "ACAR.forces.ac_tire'

PROPERTY_FILE = 'mdids://Citroen2CV/tires.tbl/front_wheels_c2cv_pac89.tir'
CONTACT _TYPE = 'handling'

S PARAMETER

[PARAMETER]

{parameter_name symmetry type  value}

'kinematic_flag " 'single ' ‘integer' O

'graphics_angle_offset ' 'left/right' 'real' 0.0

S MDI_HEADER

[MDI_HEADER]
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FILE_TYPE = 'sub'
FILE_VERSION = 7.0

FILE_FORMAT = 'ASCII'

S SUBSYSTEM_HEADER

[SUBSYSTEM_HEADER]

TEMPLATE_NAME = '<acar_shared>/templates.tbl/_brake_system_4Wdisk.tpl'

MAJOR_ROLE = 'brake_system'

MINOR_ROLE = 'any'

TIMESTAMP = '2017/07/04,17:24:57'

S UNITS
[UNITS]

LENGTH = 'mm'

FORCE = 'newton’

ANGLE = 'deg'

MASS = 'kg'

TIME = 'sec'

S PARAMETER
[PARAMETER]

{parameter_name symmetry  type  value}
'kinematic_flag "'single ' ‘integer' O
'front_brake_bias " 'single ' 'real' 0.65
'front_brake_mu " 'single ' 'real' 0.2
'front_effective_piston_radius' 'single ' 'real' 100.0
'front_piston_area " 'single ' 'real' 1000.0
'front_rotor_hub_wheel_offset' 'single ' 'real' -15.0
'front_rotor_hub_width " 'single ' 'real' 40.0
'front_rotor_width ' 'single ' 'real' -25.0
'max_brake_value " 'single ' 'real' 20.0
'rear_brake_mu "'single ' 'real' 0.2
'rear_effective_piston_radius ' 'single ' 'real' 90.0
'rear_piston_area ' 'single ' 'real' 900.0
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'rear_rotor_hub_wheel_offset ' 'single 'real' -15.0

'rear_rotor_hub_width 'single ' 'real' 40.0

'rear_rotor_width 'single real' -25.0
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